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Introduction

This guide provides an overview and description of the
basic skills and terminology required to operate the
following Elixir Windows-based applications.
The Elixir Desktop, a user interface for launching
Elixir applications such as ElixirForm, ElixirFont
and ElixirImage. The Elixir Desktop also provides
quick access to Elixir converters that convert
form, font, image and document files between
Elixir and other formats. You can edit Elixirformat files using the appropriate Elixir application
(ElixirForm, ElixirFont or ElixirImage), and convert
them back to the original or a different format using the Desktop.
ElixirForm, a forms creation package for creating
and editing Elixir-format forms, which you can
then convert to other formats using the Desktop.
ElixirFont, a font editor used for creating and editing Elixir-format fonts, which you can then convert
to other formats using the Desktop.
ElixirImage, a bitmap editor used for creating or
editing Elixir-format images, which you can then
convert to other formats using the Desktop.
Each Elixir application has a user guide to which you
can refer for detailed information. For information
about error and operational messages, see "Appendix
A, Troubleshooting".
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Notes and cautions
Elixir user guides may contain a "Notes and Cautions"
section. Before using an Elixir application, we recommend that you read the "Notes and Cautions" section
applicable to the application. You can also access
this information by viewing the release notes.

Release notes
Release notes appear at the beginning of the Elixir
software install process, so that you can review each
entry before performing the complete installation.
Once the software is installed, release notes can be
accessed from the Help menu of the application. Release notes are formatted for viewing in Notepad or
Wordpad. They have a txt file extension and are
found in the drive:\ELIXIR \RELNOTES directory.

Customer support
If you have purchased your Elixir product directly from
Elixir Technologies then contact the support center for
your region at the number listed below.
North and South America:
+1 805 641 5900 ext. 3
Asia Pacific
+92 (0) 51 206182
Europe
+420 2 2431 13877
The U.S.A. Elixir Customer Support Center provides
telephone technical assistance for Elixir users Monday
through Friday from 6:30 a.m. to 5:00 p.m. Pacific
Standard Time.
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If you have any problems running or using Elixir PrintDriver or associated Elixir applications, contact the
support center in your region for help. An Elixir product specialist will answer your call and ask for the following information:
your name, organization, telephone number and
address.
the name and version number of the Elixir
application.
a complete description of the problem, including
any error messages displayed on your monitor or
printed at your printer.
You can contact Elixir support by accessing the Elixir
World Wide Web page (and selecting [Contact Support]) at http://www.elixir.com. Please complete the
question form.
Elixir Web site support
The Elixir Web site at http://www.elixir.com offers the
following resources:
Raise a question for Elixir Support.
Find answers in the list of Frequently Asked
Questions.
Review the latest Tips and Techniques for increasing productivity using Elixir software.
Download new releases and the latest patches.
View Release Notes for the latest available
features.
Learn in the user newsgroup how others are using Elixir products.
Sign up for an Elixir Learning Program.
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Elixir training
Elixir Technologies Corporation offers training for our
full range of Windows-based family of products. For
more information, contact the Elixir Learning center,
or vist our website at www.elixir.com
Elixir Learning
(805) 641-5900 ext. 6

Who should use this guide
This guide is intended for users who are familiar with
Windows and who want to install the Elixir Desktop
and Converters and its associated applications (ElixirForm, ElixirFont and ElixirImage). This guide also
provides a quick overview of the Elixir Desktop and its
associated applications and instructions on how to
use the basic features associated with these applications.

System requirements
This section lists the hardware and software requirements for running the Elixir Desktop and other Elixir
applications.
Hardware
Recommended PC configuration: Pentium (or
100% compatible), with at least 133 MHz processor
(or the fastest commercially available processor); 32
MB RAM, 500+ MB hard drive, one CD-ROM drive.
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Additional hardware requirements:
any monitor with driver software supporting Windows in VGA, SVGA, or Sigma LaserView.
any Windows compatible mouse.
any PC-to-mainframe or communications board
that supports binary file transfers (such as IBM
PC3270, IRMA FT/3270, or AS/400 PC communications packages).
One or more of the following peripheral devices:
AFP compatible printers.
HP LaserJet II or compatible PCL 4 printer.
digital scanner and associated software with
ability to create .PCX or .TIF images at 300
or 300 dpi.
Software
Software requirements: Microsoft Windows 95, Windows 98, or Windows NT 4.0 or later.
While we make every effort to ensure the proper operation of our software, some problems cannot be resolved due to differences in the operating systems.

Conventions
Most of the following conventions are the same or
similar to Windows conventions.
display conventions
typographical conventions
mouse operations
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Display conventions
The Elixir Desktop, ElixirForm, ElixirFont and ElixirImage all adhere to Microsoft Windows conventions
for using menus, menu commands, dialog boxes,
command buttons, icons and mouse. See your Windows manual for more information.
Typographical conventions
The following typographical conventions are used
throughout this guide and other Elixir product guides.
Keystrokes are shown enclosed in < > (angle
brackets). For example:
<Enter>
Key combinations are denoted by a plus sign between keys. For example:
<Shift> + <F1> indicates to simultaneously press
the <Shift> and the <F1> keys.
Menu titles are shown in bold. Menu options are
enclosed in [ ] (square brackets). For example:
Select [New] from the File menu.
Commands, options, actions, and parameters
that require description are shown in bold followed on the next line by the description. For example:
Delete
Deletes the selected files.
Steps in a procedure are shown in numbered bold
paragraphs. For example:
1.

At the prompt, enter the file name and
extension.
Comments relating to a step (such as this paragraph) are shown in regular text following the bold
paragraph.
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Commands you enter at the DOS prompt are
shown in larger text. Within DOS commands,
variable names and keys you press are shown in
italics. For example:

CD \ELIXIR <Enter>
Mouse operations
You can perform most operations in Elixir applications
by using the mouse. The terminology is similar to
other Windows based applications.
Mouse operations are performed using the left or right
mouse buttons, depending on the specific task.
The following mouse related terms are used in this
guide:
click
to momentarily press and release the left mouse button once. A right mouse button click is specified
where necessary. For example,
Click on the right mouse button to finish entering text.
double-click
to click the left mouse button twice in rapid
succession.
drag
to click and hold the mouse on an item and move the
item with the mouse.
drag and drop
to drag an item as above, then release the mouse button, once the item is positioned over a the area. If the
selected object is a file and the destination is a directory, the file copies to the directory.
object
a selectable item on the screen.
open
to point and double-click on an icon -- the effect of this
operation depends on the icon.
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point
to move the mouse to position the screen pointer on
an area of the screen.
select
to point to an object and click the mouse -- this usually
highlights the object.
<Alt>click
to hold down the <Alt> key while pressing the left
mouse button -- this allows you to select a range of
files in a window.
<Ctrl>click
to hold down the <Ctrl> key while pressing the left
mouse button -- this allows you to select individual
files from a group in a window.
<Shift>click
to hold down the <Shift> key while clicking the mouse
-- this allows you to select more than one object at a
time.

On-line Help
Elixir software uses the Microsoft Windows Help program to provide on-line Help for all functions.
For more information about Windows Help, select the
[How to Use Help] option in the Help menu, or see
your Microsoft Windows documentation.
The Help files included with your Elixir software include graphics created using screen drivers with large
fonts. If you use a screen driver with small fonts, the
Help file graphics may not display clearly. For optimum graphics display, use a screen driver with large
fonts.
You can display on-line Help in the following ways:
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Bubble Help
Click on an icon with the right mouse button to view its
properties (if applicable) or to display "bubble help."
Bubble help is a short description of the icon function
that displays in a bubble extending from the icon.
Quick Help
Enable the quick function by selecting the quick help
option in the Usage Switches (or Preferences -- for
ElixirImage) dialog box. When you move the screen
pointer over an icon on the screen, a short description
of the icon function displays in the message area of
the screen. During certain operations a message
about the function you are performing also displays in
the message area. To see these operational messages, disable quick help.
Context sensitive Help
To use this function, click on an icon and press <F1>.
If available, the appropriate Help topic displays. If no
specific topic is available, the Help table of contents
displays.
Help menu
Select [Help] from the top pull-down menu and choose
one of the displayed topics.
Dialog box Help
Click on the [Help] button in a dialog box to view an
associated Help topic. Under Windows 95 and Windows NT, right-click on a dialog box option to display
an associated Help topic.
Help pop-ups and jumps
Within Help topic text, words or phrases underlined in
green are pop-ups or jumps. When you click on a
pop-up topic, a box displays within the current Help
topic with additional information. When you click on a
jump, a different, associated Help topic displays.
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Help hypergraphics
Hypergraphics are special graphics within Help files
that contain "hot spots". Hot spots are either pop-up
topics or jumps. Hypergraphics in Elixir Help are most
commonly dialog boxes with option hot spots (pop-up
definitions), toolboxes with tool hot spots (topic
jumps), and menus with option hot spots (topic jumps
or pop-up definitions).
Move the cursor over a hypergraphic until a hand displays, then click on this hot spot to display a pop-up
topic, or a "jump". To close a pop-up topic, click the
mouse button. To return to the original Help topic
from a jump, click on <Back> in the Help file menu.

Using Online documentation
This section describes how to use PDF online documentation, including navigating through the online
guides and printing the guides. Acrobat Reader is
provided with the online documentation. Information
about using the Acrobat Exchange program is included for users who have licenses for that program.
Accessing online guides
The PDF online documentation is copied to the
drive:\Elixir\help\pdf directory during the installation of
Elixir Suite for AFP. If you didn't choose to copy the
PDF online documentation during the installation, you
can view a complete list of the files by clicking on the
Windows [Start] button and selecting Programs>Elixir
Applications>Elixir Suite for AFP. Once the application
is launched, click on the Help menu and select Release Notes. Wordpad displays a current list of supporting documents and the directories where they can
be found on CD-ROM.
When the appropriate PDF file is accessed the Acrobat Reader program is launched and the List of Online
Guides is displayed. Click on a guide to view its table
of contents and jump to individual chapters.
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The following list of PDF files and associated document names are installed in the drive:\Elixir\help\pdf
directory.
StartAFP.pdf - Getting Started User Guide
DeskAFP.pdf - Elixir Desktop and Converters
for AFP User Guide
FormAFP.pdf - ElixirForm User Guide
FontAFP.pdf - ElixirFont User Guide
ImageAFP.pdf - ElixirImage User Guide
PdAFP.pdf - Elixir PrintDriver for AFP User
Guide
PdNT.pdf - Elixir PrintDriver for NT User
Guide
AppAFP.pdf - Elixir AppBuilder for AFP User
Guide
Transfmr.pdf - Elixir Transformer Suite User
Guide
Viewer.pdf - ElixirViewer User Guide
Elxscan.pdf - ElixiScan User Guide
Navigating in online guides
After loading a PDF document in Acrobat Reader or
Exchange program (as described above), you can
navigate through the online guide by clicking on the
following:
TOC chapter titles - jumps to the beginning of the
chapter indicated.
[Next Page] or [Previous Page] in the Toolbar - jumps
to the next or previous page of the online guide (alternatively, you can use the <Page Up> and <Page
Down> keys).
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[Go Back] in the Toolbar - returns to your previous
location.
[First Page] in the Toolbar - returns to the opening
screen of the online guide.
Word find
This option finds a key word or phrase in the current
document.
To use Word Find in a document:
1.

Click on the [Find] icon in the Toolbar.

2.

Enter the desired search text and click on
[Find].
The Acrobat Find dialog box closes and the first
occurrence of the text is highlighted.

3.

To find more occurrences of the same text,
click on the [Find] icon in the Toolbar and
then click on [Find Again] in the Find dialog
box.

Page scrolling
You can move a document on the screen to view portions of it not visible in the window, or read a document which contains article threads by clicking the
mouse to scroll through the document without using
the scroll bar.
To move a document on the screen for viewing (functional only when the document displays wider than the
document window):
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1.

Click on the [Hand] icon in the Toolbar.

2.

Hold down the mouse button and drag the
cursor in the desired direction.
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To follow the flow of text in a document that contains
article threads (automatic text flows):
1.

Click on the [Hand] icon in the Toolbar.

2.

If the document contains article threads, a
“down” arrow displays on the Hand icon.

3.

Position the hand-shaped cursor over a
paragraph and click on the paragraph to begin
reading.

4.

Continue clicking to follow the flow of text.

Zoom in/out
To magnify the size of the page display, click on the
Zoom icon in the Toolbar, then click in the Work area.
Each click resizes the view by a factor of two.
To reduce the size of the page display, click on the
Zoom icon in the Toolbar, then hold down the <Ctrl>
key and click in the Work area.
You can also click on the [%] button at the bottom of
the screen and select a zoom percentage from the
pop-up list.
Printing online guides
You can print individual chapters or an entire book to
PostScript or HP printers:
1.

Open the file.

2.

Select File>Print.
The Print dialog box displays.

3.

Select your printing options and click on [OK].
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Organization of this guide
Chapter 1, "Introduction," provides an overview of
Elixir software and documentation and describes the
hardware software and memory required for installing
and using Elixir software.
Chapter 2, "Installation," provides instructions on how
to install Elixir Software.
Chapter 3, "Desktop basics," provides an overview of
the Elixir Desktop and instructions on how to perform
basic Desktop operations.
Chapter 4, "ElixirForm basics," provides an overview
of ElixirForm and instructions on how to perform basic
ElixirForm operations.
Chapter 5, "ElixirFont basics," provides an overview of
ElixirFont and instructions on how to perform basic
ElixirFont operations.
Chapter 6, "ElixirImage Basics," provides an overview
of ElixirImage and instructions on how to perform basic ElixirImage operations.
Appendix A, "Troubleshooting," provides troubleshooting procedures, and lists all operational and error
messages issued by the Elixir Suite for AFP products.
Glossary.
Index.
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Starting Elixir applications
This section describes how to start the Elixir Desktop,
and its associated applications (ElixirForm, ElixirImage and ElixirFont).
Using Windows 95, Windows 98, or Windows NT:
Start the Elixir Desktop by clicking on the [Start] button
and choosing Programs> Elixir Applications> Elixir
Suite for AFP.
The Elixir Desktop displays.

Figure 1-1. Elixir Desktop window
Note: If you are using a monochrome monitor and
have difficulty reading the title bar text, select [Usage
Switches] from the System menu. In the Usage
Switches dialog box, select [Monochrome Monitor].
To start ElixirForm, ElixirImage or ElixirFont, doubleclick on the corresponding ElixirForm, ElixirImage or
ElixirFont icons on the Desktop.
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For example, double-click on the ElixirImage icon to
start ElixirImage and display the ElixirImage window.

Figure 1-2. ElixirImage window

Sub-window menus
All Elixir applications offer additional functionality to
normal Windows operations by allowing functions
such as pull-down menus in sub-windows (or "child"
windows).
The following figure displays a sub-window menu selection from the Elixir Desktop.
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Figure 1-3. Elixir sub-window menu

Exiting Elixir applications
To exit the Elixir Desktop or any of its associated
applications:
Double-click on the Close button at the top left of
any Elixir application.
Press <Alt> + <F4>.
Press <Alt> + <X>.
From the File menu and select [Exit]
Click on the [X] at the top right corner of the application window.
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Forms creation process
This section describes the forms creation process and
how Elixir applications fit into the process.
Forms creation overview
A form is a single-page document that contains elements such as lines, boxes, text and images. The following summarizes the steps involved in the forms
creation process.
Input/Conversion
Collecting appropriate resources, such as fonts
and images, and then converting them to a format
for editing or using within a composition.
Editing and composition
Organizing and structuring the resources gathered in the Input/Conversion process.
Data integration
Putting resources in a form to make the form
meaningful.
Proof-printing
Printing the form on a proof-printer to ensure that
all resources print correctly.
Revising
Reviewing the proof-printed form, and making
changes or corrections.
Final printing and distribution
Printing multiple copies of the form on a production printer and distributing them to the target
audience.
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How Elixir fits into the forms creation process
By describing how to use Elixir applications to create a
form, you will learn how Elixir fits into the forms creation process.
See the "References" section that follows for more information on performing the following steps.
To create a form using Elixir applications:
4.

Gather the resources (such as fonts and
graphics) that you want to place in your
document.

5.

Copy your resources to the appropriate Elixir
directories.

6.

Convert resources from AFP or other formats
to Elixir-format using the Elixir Desktop.
If you plan to proof-print, you will need to create
printer versions of your fonts using the Elixir
Desktop.

7.

Use the appropriate Elixir application
(ElixirFont or ElixirImage, respectively) to edit
fonts and images, or to create new fonts and
images.

8.

Use the ElixirForm application to compose a
form that includes the resources created in
the previous steps.
You will need to create screen versions of the
fonts and images you created in the previous
steps (using the Elixir Desktop) to see your fonts
and images in ElixirForm.
If you want to create a multiple-page document,
use the Elixir Desktop to create a .DAT file that
references two or more forms.

9.

Proof-print your form.
Verify that your form prints correctly.
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10. Convert your form to the appropriate printer
format using the Elixir Desktop.
11. Print your form on the appropriate printer.
References
This section lists the chapters in this and other Elixir
application user guides where you can find procedures for the above steps.
This guide provides some information on the individual steps of the publishing process; however, you can
find more detailed information in the appropriate Elixir
application user guide.
Copying resources to Elixir directories
See the "Desktop basics" chapter of this guide, or the
"Additional Desktop features" chapter of the Elixir
Desktop and Converters for AFP User Guide.
Downloading resources to appropriate Elixir
directories
See the "File transfer" chapter of the Elixir Desktop
and Converters for AFP User Guide.
Converting resources to Elixir-format
See the "Desktop basics" chapter of guide, or the
"Elixir Folders" and "Additional Desktop features"
chapters of the Elixir Desktop and Converters for AFP
User Guide.
Editing fonts using ElixirFont
See the "ElixirFont basics" chapter of this guide, or the
"Editing fonts" chapter of the ElixirFont for AFP User
Guide.
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Editing images using ElixirImage
See the "ElixirImage basics" section of this guide, or
the "ElixirImage basics" chapter of the ElixirImage for
AFP User Guide.
Using ElixirForm to compose a form
See the "ElixirForm basics" chapter of this guide, or
the "ElixirForm basics" chapter of the ElixirForm for
AFP User Guide.
Creating screen versions of fonts and graphics
See the "File conversions" chapter of the Elixir Desktop and Converters for AFP User Guide.
Creating a .DAT file
See the "File conversions" chapter of the Elixir Desktop and Converters for AFP User Guide.
Proof-printing a form
See the "ElixirForm basics" chapter of this guide, or
the "ElixirForm basics" chapter of the ElixirForm for
AFP User Guide.
Converting your form to the appropriate format
See the "Desktop basics" chapter of this guide, or the
"Elixir Folders" and "File conversions" chapters of the
Elixir Desktop and Converters for AFP User Guide.
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Installation

This chapter describes procedures for installing the
Elixir Desktop for the first time, and over an existing
version.

Before installation
Read the notes supplied with the Elixir installation program before installing or reinstalling the Elixir software, or before using a tape drive.
Complete the software licensing process (See the
"Product Registration" section).
All Elixir applications described in this guide are
installed using the supplied CD-ROM.
First time installation (of a Desktop application)
requires at least 26 MB of free space on your
hard disk drive. Selecting multiple applications
will require additional disk space. Reinstallation
requires less disk space as the installation procedure overwrites existing Elixir application files.
Each time you reinstall Elixir software, you overwrite existing program files and utilities with new
ones. You should select backup files when
reinstalling.
To avoid any possible conflicts, exit all other applications before installing Elixir software.
If you want to abort installation at any time during
the process, click on the [Cancel] button from the
install screen or press the <Esc> key. You will be
prompted to abort.
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Font considerations
If you plan to create or modify fonts for use on AFP
printers, the "AFP font conversion considerations" appendix includes information that is crucial to successful font conversion operations. You should read the
"Font strategy" section of this appendix to determine
how you should configure your Elixir environment
based on the strategy you want to use for converting
and using AFP fonts.
Selecting the Country Keyboard Map
During installation, your Country Keyboard Map and
Default Code Page are automatically detected. If the
installation is unable to detect your map and code
page, prompts for selecting them display, and you can
configure your default Elixir environment as described
in this section.
A Country Keyboard Map is the translation table Elixir
software uses to assign hexadecimal PC (ASCII) keys
to AFP font Graphic Character IDs (GCIDs). You can
find a description of the structure of a Country Keyboard Map in the "AFP font conversion considerations" appendix of the Elixir Desktop and Converters
for AFP User Guide.
When converting an AFP font for use in ElixirForm or
for proof printing, you can convert the entire character
set or a subset of the character set to Elixir. The subset, a "PC mapped" Elixir font, contains only the characters listed in the Country Keyboard Map.
If the primary purpose of converting AFP fonts to Elixir
is to create forms, creating a "PC mapped" font significantly reduces hard disk space use.
The Elixir Desktop provides a number of Country Keyboard Maps suitable for most applications. When installing, select the one that most closely meets your
needs.
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When you run the Elixir Desktop, you can change the
default Country Keyboard Map (described in the
"Desktop configuration" chapter of the Elixir Desktop
and Converters for AFP User Guide), or you can create your own custom Country Keyboard Map as described in the "AFP font conversion considerations"
appendix of the Elixir Desktop and Converters for AFP
User Guide.
The following table lists the Country Keyboard Maps
(ASCII .KMP files) provided at the time of publication.
.KMP file

Description

T100437.KMP

Personal Computer for US
English, UK English, and
European languages using the
IBM character set

T1000850.KMP

PC Multilingual 1 for IBM PC
multinational keyboards

T1000852.KMP

Latin2, Multilingual 2 (Slavic
for Croatian, Czech, East German, Hungarian, Polish, Romanian,
Slovak,
and
Slovenian

T1000855

Cyrillic

T1000857.KMP

Latin 5 (Turkish)

T1000860.KMP

Portugal

T1000861.KMP

Iceland

T1000862.KMP

Hebrew

T1000863.KMP

Canadian French

T1000864.KMP

Arabic

T1000865.KMP

Nordic

T1000869.KMP

Greek
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Selecting the Default Code Page
If the installation cannot detect
Page, the program prompts you
Code Page from the list of Code
Default Code Page is the Elixir
Code Page.

your Default Code
to select a Default
Pages supplied. A
version of an AFP

An AFP Code Page is a translation table used by AFP
fonts to assign host (EBCDIC) code points to Graphic
Character IDs (GCIDs). See the “AFP font conversion
considerations” appendix of the Elixir Desktop and
Converters for AFP User Guide for more information.
An Elixir Code Page is an ASCII .COD file which you
either create when you convert the full character set of
an AFP font to Elixir format, or is supplied by Elixir.
You use the Elixir Code Page when converting an
Elixir font to AFP format for the first time (i.e., if the
Elixir font was not originally converted from an AFP
font). After converting, an AFP Code Page, a required
component of the AFP font, generates.
The Default Code Page you select at installation will
be the default Elixir Code Page when you run the Elixir
Desktop. You can change the default to another Code
Page as described in the "Desktop configuration"
chapter of the Elixir Desktop and Converters for AFP
User Guide. The Default Code Page, in conjunction
with the Country Keyboard Map, translates PC ASCII
characters to EBCDIC characters when you convert
overlays to or from Elixir-format.
You can also download an existing AFP Code Page
from your host computer to the appropriate directory,
convert it to Elixir format, and use it as a default. See
the “File transfer” chapter of the Elixir Desktop and
Converters for AFP User Guide for information about
downloading AFP resources, the Code Page directory,
and converting Code Pages.
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At installation, select the Elixir Code Page that most
closely matches your requirements. For additional information about AFP font conversions, see the “File
conversions” chapter and “AFP font conversion considerations” appendix of the Elixir Desktop and Converters for AFP User Guide for more information.

Product Registration
Elixir products no longer require ElixiKey hardware devices attached to your parallel port. Elixir products
now utilize soft key technology. This new licensing
process validates your license agreement with Elixir
and places a file (password.epw if an Elixir customer,
or License.dat if a Xerox customer) on your
workstation.
Version 4.00 implements Elixir's new licensing process and discontinues use of the current hard keys. All
customers must register/re-register software license(s) by using the Elixir registration program provided
with the software.
Each product installed is assigned to a specific pc.
This pc number, your customer number, and password are required. This information is provided when
you purchase Elixir software or when you upgrade to
version 4.00 of Elixir products.
If you are an Elixir customer, registration can be completed automatically if you have an internet connection
on your workstation. If you are a Xerox customer you
must contact Xerox to register your products.
This section describes the registration process for
those customers who have purchased their Elixir
products form Elixir Technologies.
The following scenarios describe the registration
process for Elixir customers. Xerox Corporation will
provide a separate document that describes registering your products with Xerox.
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you are a new customer and will use Soft Key
registration
you are an existing customer and will change to
Soft Key registration
Elixir Product Registration screen
Make your selections according to your needs and go
to the appropriate section for further procedures.

Figure 2-1. Elixir Product Registration screen
Using the internet
You can register and download all registration files via
the Elixir Product Registration program. There are
two ways to register your products using the Internet:
down load the product registration file directly to
the Elixir PC via the Internet (see "Registering as
a new customer via the internet")

2-6

ELIXIR TECHNOLOGIES CORPORATION

INSTALLATION

download the product registration file to another
machine and move it to the Elixir PC (see "Downloading via the internet to a non-Elixir PC")
Registering as a new customer via the internet
You will receive a "Customer Activation Letter" with
your product(s) ordered. The registration process
should be completed before installing your software.
The installation CD will launch and install the Registration Program.
To install the registration program on your Elixir PC:
1.

In the Software Registration screen, click on
[Next].

2.

Select the drive and click on [Next].

3.

In the Start Registration Process screen, click
on [Install].
The password file will be installed and your system configured.

To complete registration:
1.

In the Elixir Product Registration "Welcome"
screen, select [Next].
Your machine serial number displays.

2.

Enter your customer number (from Activation
Letter), then click on [Next].

3.

Enter your password and the PC number you
want to register, then click on [Next].

4.

Select [Prepare and download my initial
product license registration. This workstation
or another pc is connected to the internet]
from the Registration Option menu, then click
on [Next].

5.

In the Download Password screen, click on
[Yes].
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The system displays your customer information
and you must verify that it is correct.
6.

When the screen displays the registration
information, click on [Save]. You may also
print this screen for reference or to send to
Elixir.

The application installation process will begin, see the
"Installation" section.
Downloading via the internet to a non-Elixir PC
You will receive a "Customer Activation Letter" with
your product(s) ordered. The registration process
should be completed before installing your software.
The installation CD will launch and install the Registration Program.
To install the registration program on your Elixir PC:
1.

In the Software Registration screen, click on
[Next].

2.

Select the drive and click on [Next].

3.

In the Start Registration Process screen, click
on [Install].
The password file will be installed and your system configured.

To complete registration:
1.

In the Elixir Product Registration "Welcome"
screen, select [Next].
Your machine serial number displays.
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2.

Enter your customer number (from Activation
Letter), then click on [Next].

3.

Enter your password and the PC number you
want to register, then click on [Next].
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4.

Select [Prepare and download my initial
product license registration. This workstation
or another pc is connected to the internet]
from the Registration Option menu, then click
on [Next].

5.

In the Download Password screen, click on
[No].

6.

In the How to Contact Elixir screen, click on
[Print] and take the printout to the pc
connected to the internet.

7.

Access
the
Elixir
Web
site
at
http:\\www.elixir.com. and click on [Product
Registration].

8.

In the Customer Information screen, enter
your Customer Number and Password, then
click on [Submit Form].

9.

In the Elixir Customer Menu,
[Download a New License File].

click

on

10. In the Customer Information screen, enter
your PC Number and Machine Serial Number,
then click on [Submit Form].
11. In the Elixir Technologies screen, click on
[Click here to download your password].
12. Save the password.epw file to diskette and
copy it to your Elixir PC in the \ELIXIR
directory.
The application installation process will begin, see the
"Installation" section.
Contacting Elixir (no internet connection)
If you have no internet access at your site you must
contact Elixir and provide the serial number of the pc
where you will install the Elixir software. Elixir will provide a registration file (password.epw) that you must
copy to the Elixir pc.
Copy the password.epw file to \Elixir and start the
installation.
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Select [Prepare my initial product license registration.
This workstation is not connected to the Internet] from
the Registration Option menu, then click on [Next].
The application installation process will begin, see the
"Installation" section.
Soft key customers running Windows for Workgroups 3.1 or 3.11
Since Windows 3.1/3.11 does not have internet capability, you must contact Elixir to obtain your password
file. After installation of Elixir software, the installation
program verifies that the operating system is 3.1 or
3.11, runs passwd16.exe, and provides your machine
serial number.
To complete registration:
1.

Enter your customer number, password and
PC number, then print out a copy of this
screen.

2.

Fax, email, or mail Elixir the display printout.
Elixir will generate a password.epw file and
send it to you on diskette.

3.

Load the password.epw file in the \ELIXIR
directory.

The application installation process will begin, see the
"Installation" section.

Installation
This section describes how to install Elixir software
using the [Full] and [Custom] options. Installing additional Elixir applications to an existing version is also
explained.
Note: The software registration process must be completed (See the "Product Registration" section).
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For information about starting Elixir applications after
installation, refer to the "Introduction" chapter.
During installation, the log file, XWIN.log, is created in
the drive:\Elixir directory. XWIN.log contains a list of
all directories and files copied or created, including information pertinent to the installation. It can be accessed, using Notepad or Wordpad.
If you have any problems running Elixir software after
installation, refer to the "Troubleshooting" section of
the Elixir Getting Started Guide for more information.
Installing Elixir applications
Elixir provides a simple, interactive procedure for installing Elixir applications.
During installation you can select [Full] or [Custom]
installation.
Selecting a [Full] installs all Elixir applications and
demonstration files on the same drive. If you
have a previous version of Elixir software, this option overwrites the existing version.
Selecting a [Custom] installation allows you to
choose the Elixir applications and options (such
as Elixir demonstration files) you want installed,
as well as where you want certain options installed. For example, You may want the PDF
documentation in a different directory than the application.
You can also install Elixir program files (required
to run Elixir), and data files (files that you create
or files such as the Elixir demonstration files), in
separate drives and directories.
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Full installation
To begin installation:
You can quit installation at any time, by pressing the
<Esc> key.
1.

Close all active applications.

2.

Insert the CD in your CD-ROM drive.

3.

In the "Welcome" screen, click on [Next].
The Release Notes? screen displays.

4.

Select [Read Release Notes Now] to display
them in Wordpad (or Notepad), or click on
[Next] to proceed with the installation.
The Product Selection screen displays.

5.

Select the applications you want to install and
click on [Next].
The Selected Products screen displays.

6.

Verify the listed applications and click on
[Next]. If you need to delete or add to the list,
click on [Back] and reselect.

7.

Verify your user information and click on
[Next].

8.

In the Select Install Type screen, select [Full]
and click on [Next].

9.

Select the drive on which you want Elixir
software installed, then click on [Next].

10. Select the Programs Folder in which you want
Elixir software installed (Elixir Applications is
the default), then click on [Next].
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11. In the Backup Replaced Files screen, click on
[Yes], if you want to make back-up copies of
all files replaced during installation and select
the directory where the back-up files will be
placed. Then click on [Next].
12. In the Start Copying Files screen, click on
[Install].
Installation begins.
13. Once installation is complete, click on [Exit
Installer].
Custom installation
To begin installation:
You can quit installation at any time, by pressing the
<Esc> key.
1.

Close all active applications.

2.

Insert the CD in your CD-ROM drive.

3.

In the "Welcome" screen, click on [Next].
The Release Notes? screen displays.

4.

Select [Read Release Notes Now] to display
them in Wordpad (or Notepad), or click on
[Next] to proceed with the installation.
The Product Selection screen displays.

5.

Select the applications you want to install and
click on [Next].
The Selected Products screen displays.

6.

Verify the listed applications and click on
[Next]. If you need to delete or add to the list,
click on [Back] and reselect.

7.

Verify your user information and click on
[Next].
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8.

In the Select Install Type screen, select
[Custom] and click on [Next].

9.

In the Configuration Only? screen:
Selecting [Yes] allows you to load Configuration, Program, and Data files into any resident directory.
Selecting [No] allows you to deselect options
you do not wish installed.

10. Select the Programs Folder in which you want
Elixir software installed (Elixir Applications is
the default), then click on [Next].
11. In the Backup Replaced Files screen, click on
[Yes], if you want to make back-up copies of
all files replaced during installation and select
the directory where the back-up files will be
placed. Then click on [Next].
12. In the Start Copying Files screen, click on
[Install].
Installation begins.
13. Once installation is complete, click on [Exit
Installer].
Adding applications
If you did not install all of the Elixir options while performing the Custom installation procedure, you can do
so at any time by following the steps described in the
"Custom installation" section of this chapter.
Adding newly licensed applications
If you purchase additional Elixir products, Elixir will
update your password file. You can access the Product Registration program from your program group
and re-download your initial product registration password file to activate your new products.
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Desktop basics

This chapter describes the Elixir Desktop layout and
basic operation.
For detailed information, see the Elixir Desktop and
Converters for AFP User Guide.

Overview
The Elixir Desktop is the Windows-based operating
environment for launching and using Elixir Suite for
AFP products such as ElixirForm, ElixirFont and
ElixirImage.
Additionally, the Desktop has many productivity enhancing features, including those which enable you to:
view files in associated applications using the
Desktop Viewer
access your entire DOS directory structure using
the User files icon
run batch files or executables from the Dispatcher
define icons for DOS-based applications such as
word processors, desktop publishers and spreadsheets.
link files to applications, thereby enabling you to
start an application and load a file in one step
run DOS commands
convert files by copying them to an icon.
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Desktop layout
The Elixir Desktop comprises two main display areas:
the Elixir Desktop menu bar
the top of the Desktop displays the Menu bar and
Message area
the remaining Desktop area displays icons.
Menu bar

Message area

Figure 3-1. Desktop window
Menu Bar
The Desktop menu bar allows you to access the following pull down menus:
File
System
Special
DOS
Window
Help
3-2
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You can pull down a menu in one of the following
ways:
Click on the menu.
Press the <Alt> key along with the underlined letter in the menu.
The Message area displays information about the operation in process, including relevant error and warning messages.
Note that you cannot move Desktop icons.

Icons
Each Desktop icon represents an application, folder,
utility or PC device configured for your system. Generally, the name, shape and appearance of an icon indicate its purpose or the type of action you can perform.
Elixir folder icons
The four icons displayed at the top left of the Desktop
represent specific DOS directories. You can access
files and convert them from one format to another using these icons. See the “Elixir folder structure” section of this chapter for more information.
Forms folder
Represents the drive:\ELIXIR\FORMS directory containing Elixir, Input and Output form files.

Fonts folder
Represents the drive:\ELIXIR\FONTS directory containing Elixir, Input and Output font files.
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Images folder
Represents the drive:\ELIXIR\PICS directory containing Elixir, Input and Output image files.
Documents folder
Represents the drive:\ELIXIR\DOCS directory containing document files referencing the Elixir-format files
for multi-page documents.
Note that Documents folder functionality for .PDF files
PDF option products.
Jobs folder

Represents the DOS \ELIXIR\JOBS directory and is
used with Elixir AppBuilder to create multiple Elixir
form print files called Jobs. A job includes formatting
information for the print run and individual pages, and
comprises a print ticket and form files.
Clipboard icon
Temporarily stores Elixir-format form (.ELX) files during job creation. You can copy an Elixir-format form to
the Clipboard using standard copying procedures,
then copy the form to a specific job when you need it.
User Files icon
Provides access all DOS directories and files, and
links applications to files.
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Application icons
Application icons display at the right of the Desktop
and represent Elixir products. Depending on your installation, one or more of the following icons display.
ElixirForm icon
Represents the ElixirForm application. Opening the
icon clears the Desktop and starts ElixirForm.
ElixirFont icon
Represents the ElixirFont application. Opening the
icon clears the Desktop and starts ElixirFont.
ElixirImage icon
Represents the ElixirImage application. Opening the
icon clears the Desktop and starts ElixirImage.
ElixiDoc icon
Represents the ElixiDoc application. Opening the icon
clear the Desktop and starts ElixiDoc.
ElixiDoc allows you to run all Elixir file-format conversion applications in standalone mode, directly from
DOS.
ElixirScan icon
Represents the ElixirScan application. Opening the
icon clear the Desktop and starts ElixirScan.
ElixirScan allows you to electronically generate existing (paper) forms using most commercially-available
scanners, and to edit and store the forms on your PC.
User Tools icon
The User Tools icon allows you to create and define
icons for DOS applications and batch files.
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Diskette icon
Enables you to access and format a diskette in your
PC diskette drive.

Printers icon
Enables you to access a local proof printer connected
to your PC.

Scanners icon
Enables you to configure and start a scanner connected to your PC directly from the Desktop.

Dispatcher icon
Enables you to invoke DOS commands or batch files
in which you can embed replaceable parameters.

Converter icon
Enables you to convert form, font, image and multipage document files to different formats by using simple “drag-and-drop” mouse operations.

Trashbin icon
Enables you to delete unwanted files and directories.
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Viewer icon
Enables you to view Elixir-format print or screen files
(.LP3 or .LW8 extensions), .DAT files, Elixir forms,
text and object files without having to launch the associated Elixir application.
Transformer icon
Enables you to apply utilities to AFP-format files that
generally modify the file headers.

Using the Desktop
The remaining sections of this chapter describe the
following basic Desktop operations:
accessing DOS
file management operations
converting files

Accessing DOS
The DOS menu allows you to run DOS commands
from the Desktop.
Selecting the [DOS Command] option or pressing
<Ctrl> + <D> displays a dialog box that enables you to
enter any standard DOS command. Enter a DOS
command and click on [OK] to clear the Desktop and
execute the command from the following directory:
from the root (drive:\) directory, if no windows are
open on the Desktop
from the directory corresponding to the window, if
a window is open on the Desktop.
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After the DOS command executes, the system
prompts you to enter any key to redisplay the
Desktop.
Managing files
The following sections describe basic Desktop file
management operations that are common to all Elixir
products. The operations include:
selecting files
dragging and dropping files
deleting files and folders
renaming files
duplicating files
overwriting existing files
Selecting files in an Elixir window
Files display as icons in Elixir windows. To display
files, double-click on an Elixir folder and then doubleclick on the appropriate Elixir, Input or Output folder.
If you double click on an Input or Output folder a window with more folders (representing different file formats) displays. Double-click on the appropriate folder
to display its files in a window.
To select one file, click on it. Note that the selected file
displays highlighted. To select more than one file (or
multi-select files), click on one file, then <Shift> click
on other files. The following figure shows several files
selected.

3-8

ELIXIR GETTING STARTED FOR AFP USER GUIDE

DESKTOP BASICS

Figure 3-2. Selecting files
To deselect a file, <Shift> click on it.
To select a range of files, click on the first file in the
range, then <Alt> click on the last file. The two files
and all displayed files between display highlighted.
To select all files in a directory (including files not displayed in a window) press <Ctrl> + <A>. Alternatively,
pull down the Selection menu and click on [Select
All].
To deselect all files, press <Ctrl> + <A>. Alternatively, pull down the Selection menu and select [Unselect
All]. Clicking anywhere in the window other than on a
file also deselects selected files.
Press a character to select the first displayed file in
the window starting with that character. Press the
character again to select the next file, and so on.
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File operations
With one or more files selected, you can perform file
operations by either dragging and dropping the files to
an icon, selecting an option from a pull-down menu or
entering a keyboard command.
Dragging files
To drag a selected file, click on it, hold down the
mouse button and move the mouse. A square-shaped
dragging cursor displays in the window and moves as
you move the mouse. The following figure shows a
dragging cursor example.

Figure 3-3. Dragging
cursor example
To drag more than one file, first multi-select the files,
then click on one of the selected files while holding
down the left mouse button. If you select more than
one file, a double cursor displays, representing multiple files.
Dropping files
To drop one or more files on a Desktop icon, select
the files, drag them to a position on top of the target
icon, then release the mouse button.
If dropping the files on an icon is not permissible, an
X-cursor displays.

Figure 3-4. X-cursor
Deleting files and folders
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To delete one or more files from a window, select the
files and perform one of the following actions:
drag and drop the files on the Trashbin icon
Note that you cannot open the Trashbin to retrieve deleted files; use the [Usage Switches] option in the System menu to select the [Confirm
File Deletions] option to avoid inadvertently deleting files.
pull down the File menu and select [Delete].
press <Del> on your keyboard.
The Confirmation for Command dialog box displays
with the first file selected, as shown in the following
figure.

Figure 3-5. Confirmation for Command
dialog box/Delete
The Confirmation for Command dialog box contains
the following options:
Delete
Delete the first file, then redisplay the Confirmation for
Command dialog box for subsequent files.
Skip
Do not delete the first file; redisplay the Confirmation
for Command dialog box for the next file.
Confirm OFF and Continue
Delete all the files without further prompting.
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Note that you can modify your Desktop setup so that
the Confirmation for Command dialog box never displays when deleting files, and files delete without
prompting (see the Elixir Desktop and Converters for
AFP User Guide for more information).
Deleting folders is similar to deleting files, except that
you can only delete empty folders.
Renaming files
To rename one or more files, select the file(s), then
perform one of the following actions:
press <F2>
click the right mouse button
pull down the File menu and select [Properties],
then type a new file name and extension in the
displayed dialog box.
Note that these actions change the external (DOS) file
name only.
The File Properties dialog box shown in the following
figure displays the first file name in the selected list.
The only option you can change is file name and extension.

Figure 3-6. Renaming a file
See the “Overwriting existing files” section in this
chapter for more information.
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Duplicating files
You can duplicate a file by copying it to the same
folder and renaming it. You can duplicate one or more
files in a single operation by first selecting the file(s)
you want to duplicate, then pulling-down the File
menu and selecting [Duplicate].
The Object Duplication dialog box displays with the
name of the first selected file in the list, as shown in
the following figure.

Figure 3-7. Object Duplication dialog box
1.

In the [into] option, enter the new file name
and extension for the first file you want to
duplicate.

2.

Either select [Skip] to not copy the first file or
select [Duplicate] to copy the file with the new
file name.

The dialog box redisplays showing the next file selected from the list.
Note that if you duplicate a file in any Elixir folder and
do not specify an extension for the [into] option, the
program assigns an extension appropriate for that
folder.
See the “Overwriting existing files” section in this
chapter for more information.
Overwriting existing files
If you copy or duplicate a file having the same name
as a file in the target directory, the Confirmation for
Command dialog box displays, as shown in the following figure. The dialog box shows the first duplicated
file name selected from the list.
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Similarly, if you attempt to rename a selected file with
a name that already exists in the target directory, a
warning message displays.

Figure 3-8. Confirmation for Command
dialog box/Overwrite
The Confirmation for Command dialog box contains
the following options:
Overwrite
Overwrite the file, then redisplay the Confirmation for
Command dialog box with the next duplicated file
name in the list.
Skip
Do not overwrite the existing file; redisplay the Confirmation for Command dialog box with the name of
the next duplicated file name in the list.
Confirm OFF and Continue
Overwrite duplicated files in the target folder without
further prompting.
You can modify your Desktop setup so that the Confirmation for Command dialog box never displays and
duplicate files get overwritten without prompting (see
the Elixir Desktop and Converters for AFP User Guide
for more information).
Converting files
Using the folders and Converter icon, you can convert
form, font, image and document files between Elixir
and other formats. You can edit Elixir-format files in
any installed Elixir application (such as ElixirForm,
ElixirImage or ElixirFont), and reconvert them to their
original or another format using the Converter icon.
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However, before you perform conversion operations,
you should familiarize yourself with the Elixir folder
structure.
Elixir folder structure
The structure of the Elixir folder icons is similar. Each
Elixir folder contains three subordinate Elixir, Input
and Output folders.
For example, when you open the Forms Folder icon
(by double-clicking on it), the window in the following
figure displays showing the Elixir Forms, Input Forms
and Output Forms folders.

Figure 3-9. Forms Folders window
Similarly, opening each of the other Elixir folder icons
displays a window showing subordinate Elixir, Input
and Output folders. This structure allows you to view,
edit and file form, font, image and document files having different formats.

Figure 3-10. Input, Elixir, and Output folders
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Each Input folder is similar to an "in basket" containing files you can convert to Elixir format by
copying them to the Converter icon. See the
"Converter operations" section of this chapter for
more information.
Each Elixir folder is similar to a "working area"
where you edit and view Elixir-format files.
Each Output folder is similar to an "out basket" to
which edited Elixir-format files write after you copy
them to the Converter icon. See the "Converter
operations" section of this chapter for more
information.
To use Elixir folders for file editing, follow these steps:
1.

Copy the file you want to edit or view to the
appropriate Elixir folder.
The Elixir Folder opens to display the subordinate
Elixir, Input and Output subfolders.

2.

Click on the Input folder.
The Input folder opens to display subfolders for
different file formats.
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3.

Click on the folder that corresponds to the
format of the file you are copying.

4.

Convert the file to Elixir format, as described
in the "Converter operations" section of this
chapter.

5.

Double-click on the converted Elixir-format
file to start the appropriate Elixir application
(such as ElixirImage or ElixirFont) and to load
the file.

6.

Edit the file using the tools provided by the
application.

7.

Save the file.

8.

Convert the edited Elixir-format file to the format desired.
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The converted file writes to the appropriate Output folder.
9.

Open the Output folder and copy the converted file to the desired location.

Converter operations
The simplest way to convert files is to use the Desktop
Converter icon. The following example demonstrates
how to convert an Elixir form file to another format.
Procedures for converting font, image and document
files are basically the same.
1.

Double-click on the Forms folder icon to display the Forms Folders window.

2.

Double-click on the Elixir Forms folder.
A window containing Elixir form files displays.

3.

Select the file(s) you want to convert.

4.

Copy the file(s) by dragging and dropping
them on the Converter icon.

5.

In the dialog box(es) that displays, specify the
output format(s) to which you want the file(s)
converted.
One or more output files with the correct file extensions generate and automatically write to the
appropriate Output folders.

ELIXIR FOR AFP GETTING STARTED GUIDE
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ElixirForm basics

This chapter describes basic ElixirForm operations.
For more information about ElixirForm, see the ElixirForm for AFP User Guide.

Overview
ElixirForm is an interactive forms design tool that allows you to create and edit forms in WYSIWYG
(What-You-See-Is-What-You-Get) mode.
ElixirForm creates the static (or boilerplate) components of a form, such as lines, boxes, text and images. You can then merge these static elements with
variable data and print the resulting form on an AFP
high-speed printer.
Static data adds meaning to the variable data with
which it merges. For example, the following variable
data from a credit application form
X
X

123-456-789
985-234-980

9876.23
11813.34

is more meaningful when merged with static data and
viewed together:
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With ElixirForm, you can see each static form element
as you add or change it. With an optional desktop
proof printer, you can generate proofs using the Elixir
Desktop Converter and compile forms directly on your
PC, thus freeing an AFP printer previously required for
these tasks.
You can also use the Elixir Desktop to define a multipage document (.DAT file) comprising a group of
single-page forms you created using ElixirForm . You
can then use the Desktop to convert the multi-page
document to other formats.
Depending on the ElixirForm product you have installed, your screens and options may differ from
those displayed in this chapter.

ElixirForm layout
The ElixirForm
features:

window

contains

the

following

a work area at the center of the screen
a work area Menu bar above the work area
an ElixirForm Menu bar at the top of the screen
a message area between the Menu bars
a Toolbox to the left of the screen
a Toolbar above the work area.
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Close button
Toolbox

Toolbar

Message
area

Work area
menu bar

ElixiForm
menu bar

Work area

Figure 4-1. ElixirForm window
The ElixirForm Menu bar enables you to access the
following pull down menus:
File
System
Window
Help
The work area Menu bar enables you to access the
following pull down menus:
Edit
Tools
View
Options
You can pull down a menu in either of the following
ways:
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click on the menu.
simultaneously press the <Alt> key and an underlined letter in the menu.
Toolbox <F10>
The Toolbox displays to the left of the work area and
provides tools for creating and editing form elements.
If you maximize the work area, the Toolbox displays
on top of the work area.
Tools (from left to right)
Select, Line, Path, Box,
Circle, Text and Image tools
Message panel

Tool options

Preview panel

Figure 4-2. ElixirForm Toolbox
You can toggle between hiding and showing the Toolbox by either selecting [Tools] from the Window
menu (or pressing <F10>).
The following tools (from left to right) for creating and
editing form elements display at the top of the
Toolbox:
Select tool; Line tool; Box tool; Text tool; Image tool.
When you click on a tool, a short description of the
tool displays in the message panel and the options for
the tool display in the Toolbox. You can select tool options by clicking on the icons.
The preview panel displays the option(s) you selected.
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Toolbar
The Toolbar displays across the top of the work area
and contains a digital ruler with blocks that show the
selected element, and the selected element coordinates and size. The icons in the Toolbar allow you to
show the measuring ruler, change the grid and view
settings, undo and redo operations and show or hide
the Toolbox.

Grid settings
Digital ruler

Measuring
ruler

Magnification/
Reduction

Show/hide
toolbox

Undo/Redo

Figure 4-3. ElixirForm Toolbar
Message area
When you position the cursor over an icon in the Toolbox or Toolbar, a description of the icon displays in
the message area. Operational messages also display in this area.

Creating a form
This section describes the following ElixirForm operations for creating a simple form:
loading a new form
using the grid, rulers and crosshair
creating form elements
editing selected form elements
using the undo/redo feature
modifying form elements
saving a form
proof-printing a form
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By following the procedures outlined in this section,
you can develop a simple form such as the following
fictitious "FedBank" credit application.
Note that the procedures assume that you have installed the Elixir demonstration files accompanying
your software. If not, you can install them now by performing a [Custom] installation. See the "Installation"
chapter for more information.

Figure 4-4. Sample form
Loading a new form
After you start ElixirForm, load a new form as follows:
1.

Pull down the File menu and select [New
Form].
The Page Properties dialog box displays.
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2.

Select the page property options for your
form.
See the ElixiForm User Guide for more information about options in this dialog box.

3.

Click on [OK].
The Page Databasing dialog box displays.

4.

Enter information for the new form (optional).
See the ElixiForm User Guide for more information about options in this dialog box.

5.

Click on [OK].

A new, untitled form displays in the work area.
Using the grid, rulers and long crosshair
Display the grid, rulers, and long crosshair to help
place elements accurately on your form.
To display the grid, click on the top half of the Grid
icon in the Toolbar.
You can also select the above options by pulling down
the View menu and selecting the applicable option.
The grid and rulers allow you to be precise in your
measurements.
To display the grid, click on the top half of the Grid
icon in the Toolbar.
To display the graphical ruler at the top left edges of
the work area, click on the Graphical Ruler icon in the
Toolbar.
To display the long crosshair, click on the Long Crosshair icon in the Toolbar.
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You can also turn these options on and off by selecting them from the View menu.
The Digital Ruler displays at the top left of the Toolbar
and shows the horizontal and vertical position of the
screen pointer.
Creating form elements
The following section describes how to create form
elements such as lines, boxes, paths, circles, text and
images.
Lines
To draw a line:
1.

Click on the Line icon in the Toolbox (or
select [Line] from the Tools menu).
The Line toolbox displays.

2.

Select line properties from the options listed.
Options include line direction, width, style and
color.

3.

Position the screen pointer in the work area
where you want the line to start.
Note that you can begin a line at any position on
the screen, and stretch it in any direction.

4.

Press and hold the left mouse button while
dragging the screen pointer across the work
area.
A line displays.

5.

4-8

Release the mouse button where you want the
line to stop.
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Boxes
To draw a box:
1.

Click on the Box icon in the Toolbox (or select
[Box] from the Tools menu).
The Box toolbox displays.

2.

Select box properties from the options listed.
Options include positioning, shape, number of
box splits and border width, style, shading and
color.

3.

Position the screen pointer in the work area
where you want the box to start.
Note that you can begin a box at any position on
the screen, and stretch it in any direction.

4.

Press and hold the left mouse button while
dragging the screen pointer across the work
area.
The box increases in size.

5.

Continue moving the screen pointer until the
box is sized as desired.

6.

Release the mouse button to place the box.
The box outline displays solid.

Text
To add text:
1.

Click on the Text icon in the Toolbox (or
select [Text] from the Tools menu).
The Text toolbox displays.

2.

Select text properties from the options listed.
Options include character and word spacing,
boundaries, justification, positioning, color, lines
per inch, columns and font type.
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3.

Select a font from the Toolbox font list.
The default font is at the top of the list.

4.

Position the screen pointer in the work area
where you want the text to start.

5.

Enter characters from the keyboard.

6.

Click the right mouse button when finished.

Images
To add an Elixir-format image:
1.

Click on the Image icon in the Toolbox (or
select [Text] from the Tools menu).
The Image toolbox displays.

2.

Select [Load Image] from the options listed.
The Load Image dialog box displays drive:\ELIXIR\PICS\PRINTER directory images with .LP3
extensions.

Figure 4-5. Load Image
dialog box

4-10

ELIXIR GETTING STARTED FOR AFP USER GUIDE

ELIXIRFORM BASICS

Note that pre-3.0 version Elixir software users
with only screen version images (.LW8 files) can
load them by clicking on the load image icon; this
displays a Load Image dialog box with .LW8 files
in drive:\ELIXIR\PICS\SCREEN. However, to either edit an image, tile an image into a font or create a printer version of an image, you must have
the .LP3 version.
3.

Select an .LP3 image.
To load the sample "FedBank" credit application
described at the beginning of this section, select
[FBLOGO].

4.

Click on [OK].

5.

Press and hold the left mouse button.
The image attaches to the screen pointer.

6.

Position the image on the form.

7.

Release the left mouse button to place the
image.

Undo/redo
ElixirForm allows you to undo an operation and cancel
a previous undo operation.
To undo the most recent operation, click on the
Undo icon in the Toolbar or select [Undo] from
the Edit menu. Note that ElixirForm undoes one
operation element at a time.
To cancel the most recent undo operation, click
on the Redo icon in the Toolbar or select [Redo]
from the Edit menu. Note that ElixirForm cancels
one undo operation at a time.
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Modifying form elements
You can change and delete form elements as required, and create a new form by copying elements
from an existing form. Note that the procedures are
similar for lines, boxes, images and text.
Selecting elements
You must select an element before you can modify or
copy it.
1.

Click on the Select icon, or click the right
mouse button in the work area.

2.

Click on the element you want to modify.
Boxes display around or inside the element to indicate you have selected it.
If you want to select all elements, click on [Select
All] in the Edit menu.
To deselect all, click on [Unselect All] in the Edit
menu.
<Shift>click to select multiple elements.

Moving selected elements
To move a selected element:
1.

Click on the Select icon.

2.

Select the direction for moving: [Horizontal
only], [Vertical only] or [Free].

3.

Click on the element you want to move.
Boxes display on the element to show you have
selected it.

4.
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Click on the selected element; the screen
pointer changes to a hand.
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If the screen pointer does not change to a hand
when you place the cursor on the element, it may
be because the element is too small. If this happens, press and hold the <Ctrl> key as you move
the cursor over the element. When the screen
pointer changes to a hand, move the element.
5.

Drag the element to the new position.

6.

Release the mouse button.
The element locks in the new position.

Copying selected elements
To copy a selected element:
1.

Click on the Select icon in the Toolbox.

2.

Click on the Copy icon.

3.

Select the direction for copying: [Horizontal
only], [Vertical only] or [Free].

4.

Click on the element you want to copy.
Boxes display on the element to show you have
selected it.

5.

Click on the up or down arrows to select the
number of copies between 1 and 99.
Hold down the <Ctrl> key while clicking on the arrows to increase or decrease the value by 10.
You can also backspace over the value and enter
a new value from the keyboard.

6.

Click on the selected element and drag it in
the direction you want to place the duplicate
lines or boxes.

Deleting selected elements
To delete selected elements:
ELIXIR FOR AFP GETTING STARTED GUIDE
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1.

Select [Delete All] from the Edit menu (or use
the <Ctrl> + <Del> hot key.
This command deletes all elements on the page,
even if you did not select them.
If you want to exclude certain elements from being deleted, you can click on one or more element
exception icons in the Toolbox. The element(s)
you choose do not delete during the operation.
For example, if you have a form with text, boxes
and lines on it, and you want to delete the lines
and boxes but not the text, click on the text icon
and then select [Delete all] from the Edit menu.
All lines and boxes delete, and only text remains.

Editing selected form elements
To change the properties of a selected element:
1.

Place the screen pointer on the selected
element and click the right mouse button.
The tool options for that element display in the
Toolbox.

2.

Click on a tool option to change
properties of the selected element.

the

For example, click on the box shape icon to
change a square to a rectangle.
3.

Click the right mouse button again to return to
select mode.

To change the coordinates of a selected element:
1.

Place the screen pointer on the selected
element and click the right mouse button.

2.

Place the cursor in the coordinates box in the
Toolbar and enter the new coordinates.
ElixirForm will not accept coordinates that
exceed the page limits.
Use the <Del> key to delete the whole
number
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Use the <Backspace> key to delete only the
last number
3.

Click the mouse button to accept the new
coordinates.

Saving a form
To save your form:
1.

Select [Save Form] from the File menu or
press <Ctrl> + <S>.
The Save Form dialog box displays showing the
contents of the forms directory.

Figure 4-6. Save Form dialog box
2.

Type a filename in the File name option.
You do not need to type an extension. An .ELX
extension adds to your form name and your form
saves in the drive:\ELIXIR\FORMS\ELIXIR directory.
If you plan to convert your form to other formats,
you should save the form with a maximum sixletter file name. Longer file names truncate upon
conversion and could result in overwriting existing
files.

3.

Click on [OK].
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After you name the form, you can press <Ctrl>+ <S >
to perform a quick save.
If you want to save an existing form as a new file, select [Save Form As] from the File menu (or press
<F7>), and type a new filename in the Save Form as
dialog box and click on [OK]. The program adds an
.ELX extension to your file and saves it in the drive:\
ELIXIR\FORMS\ELIXIR directory.
Proof-printing your form
To proof-print your form:
1.

Select [Print] from the File menu.

2.

Select your proof printer and other print
options from the Print dialog box.

3.

Click on [OK].
Your form prints on the selected printer.

Loading an existing form
To load the form you just created the next time you
start ElixirForm:
1.

From the File menu, select [Load Form].
The Load Form dialog box displays.
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Figure 4-7. Load Form dialog box
2.

Select the name of the form file you want to
load.

3.

Click on [OK] or double-click on the form
filename.
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5. ElixirFont basics

This chapter describes basic ElixirFont operations.
For information about ElixirFont, see the ElixirFont for
AFP User Guide.

Overview
This section describes ElixirFont, the Windows-based
bitmap font editor that allows you to create and edit
fonts in WYSIWYG (What-You-See-Is-What-You-Get)
mode.
ElixirFont along with the Elixir Desktop allows you to
easily import and convert fonts to Elixir-format, and to
edit and reconvert them back to their original or other
formats.
ElixirFont for AFP also allows you to perform the following font operations:
edit individual font characters using tools to manipulate the character bitmap
apply embolden, italicize and underline transformations to one, all or a sequence of font characters
display and edit character and font properties
such as kerning, baseline offset and orientation.
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Font basics
The Elixir Desktop allows you to convert AFP Bounded box, AFP Unbounded box, Hewlett-Packard (HP)
and Bitstream Facelift outline (contour) fonts to Elixirformat fonts.
Once converted to Elixir format, these fonts can be
resized, merged with other fonts, italicized or treated
to a variety of other editing operations. Note that the
operations you can perform on individual characters
and on the entire font depend on whether you converted the font from an AFP character set or from a
non-AFP font.
The following sections describe ElixirFont procedures
involving fonts from non-AFP sources such as HP
PCL and Bitstream Facelift.
For ElixirFont procedures involving fonts from AFP
(Bounded-box and Unbounded-box) sources, see the
"Elixir font structure" chapter of the ElixirFont for AFP
User Guide.

ElixirFont layout
The ElixirFont window comprises the following elements:
a work area at the center of the screen
a work area Menu bar above the work area
an ElixirFont Menu bar at the top of the screen
a message area between the menu bars
a Toolbox to the left of the screen
a Toolbar above the work area.
The figure below displays the ElixirFont window.
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Close Box
Toolbox

Message
area

Work Area
menu bar

ElixirFont
menu bar

Work area

Code Page Window

Figure 5-1. ElixirFont window
The ElixirFont Menu bar allows you to access the following pull down menus:
File
System
Window
Help
The work area Menu bar allows you to access the following pull down menus:
Font
Edit
Char
Transforms
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You can pull down a menu in one of the following
ways:
Click on the menu
Simultaneously press the <Alt> key and the underlined letter in the menu.
Toolbox
The Toolbox displays to the left of the work area and
provides tools for editing and transforming characters
and fonts. If you maximize the work area, the Toolbox
displays on top of the work area.

Edit selection tools
Message panel

Undo, Stop, Go buttons (from
left to right)

In this area, different options
display, depending on the
tool you select

Figure 5-2. ElixirFont Toolbox
You can toggle between showing and hiding the Toolbox by selecting [Tools] from the Window menu (or
pressing <F10>).
When you click on a tool, a short description of the
tool displays in the message panel and the options for
the tool display in the Toolbox. You can select the options for that tool by clicking on the icons.
The buttons below the editing tool options allow you to
undo the last operation, stop a conversion in progress
or apply the current tool or transformation.
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Message area
The message area displays icon descriptions, characteristics of the loaded font and error and operational
messages.
Code Page Window
This window allows you to load a Code Page (see the
"Loading a Code Page" section of this chapter for
more information).

Using ElixirFont
The following sections describe basic ElixirFont operations, including:
loading an existing font
loading a Code Page
using edit selection tools
using the edit tool
using the transform tool
creating a character set
saving a character set
Loading a non-AFP font
Each Elixir format font includes at least three components with different file extensions in the drive:\ELIXIR\FONTS\ELIXIR directory:
An .HDR component containing font header information
A .GLH component containing header information
for each character
A .GLY component containing the actual bitmaps
of the characters.
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To load a non-AFP Elixir font:
1.

Select [Usage Switches] from the System
menu.
The Usage Switches dialog box displays.

Figure 5-3. Usage Switches
dialog box
2.

Select the [Convert non-AFP font to Charset
on load] option.

3.

Click on [OK].

4.

Select [Open Charset] from the File menu or
press <F8>.
The Load Charset dialog box displays, with a list
of .HDR font components.

Figure 5-4. Load Charset dialog box
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5.

Select a non-AFP font.
Note that AFP character sets begin with C0 and
C1; non-AFP fonts can begin with any character.

6.

Click on [OK].
The Convert to Charset option dialog box displays.

Figure 5-5. Convert to Charset
option dialog box
7.

Click on [No] to load the font as a non-AFP
font.
The ElixirFont main screen displays.

Figure 5-6. ElixirFont main screen
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The Character Set window shows the character bitmaps of the font, arranged left-to-right and top-tobottom by the ASCII position of the character in the
font. The font header file defines the positions.
When you move the screen pointer to a character, its
position shows at the top of the screen in decimal and
hexadecimal notation. A gray box appears around the
current character.
Also shown is character width (in pels) and whether
the character is NULL, SPACING or NONBLANK. A
null character means that no character is defined for
this position and shows as a filled gray cell (like the
first 32 characters in the font). A spacing character
occupies a cell but does not have a bitmap and prints
as a spacing character. All other nonblank characters
contain bitmaps.
The left of the screen shows the Toolbox used to edit
and manipulate the characters or the entire Elixirformat character set. The "Using the edit tool" and
"Using the transform tool" sections of this chapter describe these and other operations.
The Code Page window is initially blank.
Loading a Code Page
A Code Page maps keyboard entries to characters in
a character set. Each key on the keyboard corresponds to a hexadecimal Code Point. When printing
on an AFP printer, the Code Point matches to a GCID
in the Code Page. This allows you to use different
code pages to print subsets of characters in a character set.
Elixir provides PC versions of code pages as
T1*.COD format ASCII files in drive:\ELIXIR\FONTS\
ELIXIR.
To load and display a Code Page in the ElixirFont
Main screen Code Page window, perform one of the
following actions:
Open a T1-, X0- or X1-prefix file in the Desktop
Elixir Fonts folder.
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Note that opening a T1 file loads a code page
only; opening an X0 or X1 file loads the code
page and its associated character set.
Make the Code Page Window the active window
and select [Open Coded Font] from the CodePage menu of press <F8>..
Make the Edit Window the active window and select [Open Coded Font] from the Charset menu.
Select [Open Code Page] from the File menu on
the ElixirFont Main screen.
The Load Code Page dialog box displays, with a list of
code pages in the default directory.

Figure 5-7. Load Code Page dialog box
1.

Select a Code Page and click on [OK].

The Code Page Window displays the selected Code
Page, as shown at the bottom of the following figure.
Note that if a character set is not present, the Code
Page displays GCID names only.
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Figure 5-8. Loaded Code Page and Character Set
2.

Select [Usage Switches] from the System
menu.

3.

Select [Highlight chars in Code Page] to
highlight characters in the selected character
set that are mapped to the Code Page.

4.

Click on [OK].

For information about editing a Code Page, see the
"Elixir font structure" chapter of the ElixirFont for AFP
User Guide.
Using the edit selection tools
Use the edit selection tools to perform edit operations
for individual characters and an entire font.
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Edit selection tools (from left to right)
Select, Edit, Transform, Kill, Char Properties
Copy, Swap, Merge, Sample, Font Properties

Figure 5-9. Edit selection tools
Using the Edit tool
The Edit tool allows you to edit an individual character
in a font. Click on its icon after loading a font to display editing tools in the Toolbox.
1.

Select and load a font.

2.

Select the character you want to edit and then
click on the Edit tool in the Toolbox.
An Edit Window similar to the one in the following
figure displays. Alternatively, you can doubleclick on a character to display the edit window.
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Figure 5-10. Editing a character bitmap
The bottom of the display shows a partial list of characters with the current character selected. You can
click on another character to display it in the Edit Window. You can also scroll through the entire font using
the <Page Up>, <Page Down>, <Home> and <End>
keys (or use the window scroll buttons or bar).
The left side of the display contains the Bitmap window which contains a bitmap of the character (initially
at 8x magnification). Each dot in the bitmap shows as
a black or white box 8 bits high and 8 bits wide. You
can edit the bitmap in the window by using the editing
tools.
The right side of the display contains the Framing window, which you can move around the character to display different character portions in the Bitmap window.
Select an editing tool to display its options. In addition, you can select options from menus in the Edit
Window menu bar and from the Edit Window Toolbar
displayed just below the ElixirFont menu bar.
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Edit Window menu bar
The Edit Window menu bar contains the following pulldown menus:
Char
Edit
Tools
View
You can pull down a menu in one of the following
ways:
Click on the menu
Press the <Alt> key along with the underlined letter in the menu.
Edit Window Toolbar
The Edit Window Toolbar contains a digital ruler and a
number of other icons which allow you to display a
grid, undo an edit operation, magnify or reduce a view,
save changes made during editing and select characters in a font.

Undo
Show
Grid
Digital ruler

Select next
character
Magnify or
reduce view

Select previous
character

Post (allows you to save edits)

Figure 5-11. Edit Window Toolbar
Editing tools
The following figure shows the editing tools available
in the Toolbox when you click on the Edit tool. Select
a tool by clicking on it, or by pulling down the Tools
menu and selecting a tool.
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Editing tools (from left to right)
Character Properties, Ruler, Copy/Move
Draw Dot, Draw Line, Draw Box, and Draw Circle
Draw with Brush, and Blend Character

Editing tool options

Figure 5-12. Editing tools
To use an editing tool:
1.

Click on the tool or select it from the Tools
menu.

2.

Select any additional options for the tool from
the Toolbox.
Selecting the Character Properties tool displays a
dialog box from which you can enter properties
for a character.
Selecting the Ruler tool displays the digital ruler in
the Edit Window Toolbar.
If you select a drawing tool, drag the mouse in the
bitmap window to edit the character using the
tool.
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Selecting the Copy/Move tool allows you to select
a rectangular area of the displayed character and
to move or copy it (by selecting the "M" or "C"
icons in the Toolbox) to another location in the
cell.
Selecting the Blend tool allows you to blend another character into the current cell. After selecting the Blend tool, click on another character in
the font to blend it with the currently loaded character in the Framing window on the right. After
positioning it, click on [Accept] at the bottom of
the Toolbox to blend the character with the
loaded character.
3.

To save your changes, click on the Post icon
in the Toolbar or select [Post] from the Char
menu.

Using the Transform tool
The Transform tool allows you to apply transformation
operations to either a single font character or an entire
font.
1.

To display transformation operations in the
Toolbox, select the Transform tool.
The transformation operations display as shown
in the following figure.
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Transformation operations (from left-to-right)
Resize, Rotate, Shift, Slant
Darken, Lighten, Underline, Reverse
Filter, Outline, Halftone, Mirror
Undo, Stop, and Go buttons

Transformation options

Figure 5-13. Transform tool and
transformation operations
2.

Load a font and select either a character or
entire font by selecting [Select All] from the
Edit menu (or pressing <Ctrl> + <A>).
To deselect a character set, select [Unselect All]
from the Edit menu or press <Ctrl> + <A>.

3.

Select a transformation operation from the
Transform menu or click on the Transform
tool and select a transformation operation
from the Toolbox.
Note that inn the previous figure, the Rotate tool
shows as selected.

4.

Select the transformation options you want.
In the previous figure the [Clockwise] Rotate option shows selected.
Note that the options in the Toolbox change depending on the transformation tool you select.

5.
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If you perform the Rotate operation shown in the
Toolbox, the character or entire font rotates 90° to
the right. Repeatedly clicking on the Go button
rotates the character(s) in 90° increments (see
the following figure).
6.

Click on the Stop button
transformation in progress.

to

stop

a

Note that if you stop the current conversion, the
undo operation may not be available.
7.

Click on the Undo button
transformation operation.

to

undo

a

a
Figure 5-14. Clockwise rotation example

Creating a character set (font)
To create an Elixir character set you can either modify
an existing Elixir character set and save it to a new
file, or you can create a new character set using the
[New Charset.] option in the Charset menu.
To create a new font using the [New Charset] option:
1.

From the Charset menu, select [New Charset].
A series of dialog boxes display requesting you to
specify properties and a name for your character
set.
See the ElixirFont User Guide for information regarding Elixir character set names and properties.

2.

After entering a filename and selecting character set properties, click on [OK].
A window with character cells (representing individual characters in your character set) displays.
The character set name you specified displays at
the top left corner of the window.
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3.

Use the Edit or Transform tools to create your
character set.

Saving a character set (font)
To save a character set to the current file:
1.

Select [Save Charset] from the Charset menu
or press <Ctrl> + <S>.

2.

Click on [OK}.

The program adds an .HDR extension and saves the
file in the drive:\ELIXIR\FONTS\ELIXIR directory.
To save a character set to a new file:
1.

Select [Save Charset as] from the Charset
menu.

2.

Type a new filename in the Save Charset As
dialog box.

3.

Click on [OK].

The program adds an .HDR extension and saves the
file in the drive:\ELIXIR\FONTS\ELIXIR directory.
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6. ElixirImage basics

This chapter describes basic ElixirImage operations.
For more information, see the ElixirImage for AFP
User Guide.

Overview
ElixirImage is a Windows-based bitmap editor that allows you to create and edit black-and-white Elixir-format images.
ElixirImage was designed to provide the environment
and drawing tools normally found on dedicated graphics workstations.
Combined with the ElixiSys Desktop, ElixirImage provides powerful features to support your AFP highspeed laser printing systems.
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ElixirImage layout
The ElixirImage window contains the following:
a work area at the center of the screen
a work area Menu bar above the work area
an ElixirImage Menu bar at the top of the screen
a message area between the menu bars
a Toolbox to the left of the screen
a Toolbar above the work area.
Close Box
Toolbox

Toolbar

Message
area

Work Area
menu bar

ElixirImage
menu bar

Work area

Figure 6-1. ElixirImage window
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The ElixirImage Menu bar allows you to access the
following pull-down menus:
System
Window
Help
The work area Menu bar allows you to access the following pull-down menus:
File
Edit
Image
Tool
Transform
You can pull down a menu in either of the following
ways:
click on the menu
simultaneously press the <Alt> key and the underlined letter in the menu.
Toolbox
The Toolbox displays to the left of the work area and
provides drawing and transform tools for creating and
editing images. If you maximize the work area, the
Toolbox displays on top of the work area.
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Drawing tools
Message panel

Click on Transform
icon to display
transform tools
Tool options or
Transform tools

Preview panel

Figure 6-2. ElixirImage Toolbox
You can toggle between showing and hiding the Toolbox by either selecting [Tools] from the Window
menu or pressing <F10>.
When you click on a tool, a short description of the
tool displays in the message panel and the options for
that tool display in the Toolbox. You can select the
options for that tool by clicking on the icons.
The Preview panel displays your option selections.
Toolbar
The Toolbar displays across the top of the work area
and contains the digital ruler and icons for magnifying
and reducing an image, undoing and redoing editing
operations, changing the drawing mode and selecting
the grid.
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Undo/Redo

Digital ruler

Magnification/
Reduction

Grid

Drawing modes

Figure 6-3. ElixirImage Toolbar
Message area
The message area initially displays the type of image
loaded in the work area (black-and-white, highlight
color or full color), operational and icon description
messages and transformation messages.

Using ElixirImage
The following sections describe basic ElixirImage operations:
loading an existing image
using the drawing tools
using the transform tools
creating an image
resetting an image
saving an image
proof-printing an image.
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Loading an existing image
With the ElixirImage main screen displayed, load an
image as follows:
1.

From the File menu, select [Load] or press
<F8>.
The Load Image dialog box displays with an alphabetical list of all available images. The images are Elixir-format .LP3 files in the drive:\
ELIXIR\PICS\PRINTER directory.

Figure 6-4. Load image
dialog box.
2.

Select one of the files (for example, select
STARS.LP3, a demonstration file supplied
with ElixirImage).
The image displays in the work area and the filename appears in the Work Area menu bar, as
shown in the following figure.
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Figure 6-5. Loaded file example
Using the drawing tools
You can edit an image by using the drawing tools. To
select a drawing tool, click on the Tool icon in the
Toolbox or select a tool from the Tool menu.
For example, to select the line drawing tool, select
[Line] from the Tool menu. The Line icon highlights in
the Toolbox and the line tool options display. Alternatively, click on the Line icon to select the Line tool.
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To set the color of your drawing tool click on the FG
button, until the color you want to draw in displays.
To use the drawing tool, drag the mouse in the work
area.
Drawing tools (from left to right)
Line, Curve, Box, and Circle
Polyline, Pencil, Brush, and Airbrush
Fill, Eraser, Text, Transform

Tool options

Click on FG
button to toggle
tool color

Preview panel

Figure 6-6. Drawing tools
You can set properties for a drawing tool by clicking
on the tool options. The options you select display in
the preview panel.
Using the Transform tool
You can use the Transform tool to apply transformation operations to an image or image area. The following figure shows the available Transform tools and
operations.
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Transform tool
Transfomation operations (from left to right)
Resize, Rotate, Mirror, Distort
Clear, Reverse, Shift, Halftone
Outline, Darken, Lighten, Filter
Import, Export
Go button
Transformation operation selected

Transformation options

Figure 6-7. Transform tool and transformation operations
To perform a transformation operation:
1.

Select a Transform tool.

2.

Select the area you want to transform by
dragging the mouse in the work area. If you
want to transform the whole area, skip this
step.
A dashed box outlines the area selected. The
transformation operation you select affects the
selected area only.

3.

Select a transformation operation from the
Transform menu or by clicking on the Transform tool and selecting a transformation operation from the Toolbox.
In the previous figure, the Rotate option is
selected.

4.

Select the transformation option(s).
In the previous figure the [180 degrees] Rotate
option is selected.
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The options in the Toolbox change, depending on
the transformation tool you select.
5.

Click on the Go button to perform the transformation operation.
The following figure shows an example of a [180
degrees] Rotate operation. Each click on the Go
button rotates the image or image area in a 180°
increment.

Figure 6-8. Rotate example
Creating an image
To create an image, you can either modify an existing
Elixir-format image and save it to a new file or you can
create a new image using the [New] option in the File
menu.
To create a new image:
1.

Select [New] from the File menu or press
<F9>.
The Image Attributes dialog displays requesting a
filename and attributes for your image.
See the ElixirImage User Guide for information
regarding the options in this dialog box, or click
on the [Help] button in the dialog box.
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2.

After selecting a filename and attributes for
your image, click on [OK].
The image displays in the work area. The name
of your image displays at the top left corner of the
work area Menu bar.

3.

Use the Edit or Transform tools to create your
image.

Resetting an image
Resetting an image clears all edits since the last save
operation. To reset an image, select [Reset] from the
File menu.
Saving an image
To save an image to the current file, select [Save]
from the File menu or press <Ctrl> + <S>. The program adds an .LP3 extension and saves the file in the
drive:\ELIXIR\PICS\PRINTER directory.
To save an image to a new file:
1.

Select [Save as] from the File menu or press
<F7>.

2.

Type a new filename in the Save Image dialog
box.

3.

Click on [OK].

The program adds an .LP3 extension and saves the
file in the drive:\ELIXIR\PICS\PRINTER directory.
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Proof printing an image
To proof-print your image:
1.

Select [Print] from the File menu or press
<Ctrl> + <Shift> + <F10>.

2.

Select your proof printer and other print options from the Print dialog box.

3.

Click on [OK].

Your image prints on the selected printer.
.
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A.

Troubleshooting

This chapter contains general information, describes
troubleshooting procedures, and lists all operational
and error messages issued by the Elixir Suite for AFP
products.
For information about minimum and maximum parameters, please refer to the appropriate Elixir Suite
for AFP product documentation or to the on-line Help
file for the product.
If you encounter "out of memory", "disk full" or other
memory or disk error, please refer to your Microsoft
Windows or MS-DOS documentation for more information.

Notes and cautions
Elixir software has been tested using HP Windows
printer drivers for proof printing. Other printer drivers
are not supported and may produce unpredictable results when used with Elixir software.

Installation
This section provides information for solving problems
you might encounter when installing the Elixir Suite for
AFP software.
When installing or reinstalling an Elixir software product, make sure that you:
Locate the Windows directory at C:\Windows. If
necessary, edit the ELXWDATA.BAT file to point
to the Windows directory.
ELIXIR FOR AFP GETTING STARTED GUIDE

A-1

TROUBLESHOOTING

Connect the appropriate ElixiKey(s) to your PC
parallel (LPT1) port. If adding a new key, delete
all program files from the drive:\ELIXIR directory
prior to reinstalling the Elixir software. See chapter 1 "introduction" for more information).
Select the proper toolset for the software product
you will use. If necessary, change the toolset and
try running the software again. See the toolset table in chapter 1 "introduction" for more
information.

Elixikeys
This section contains information for using software
protection keys with Elixir products.
If using Sentinel Pro and SuperPro, make sure to
place the Sentinel Pro keys closest to your PC.
If using more than one SuperPro protection key,
make sure to place keys with xxxxx016xx lot
numbers before those without the 16-series number.
If your PC parallel port uses a WinBond 83757 or
28375F I/O controller chip and you are experiencing difficulties, contact Elixir Technologies Customer Support for assistance.

Elixir Desktop
This section contains information for solving common
problems occurring while using the Elixir Desktop.
After installing another software package, Elixir
software operates erratically
Having a BWCC.DLL file other than in the Windows \SYSTEM directory may cause errors with
operations such as copying files to Elixir folders
using the User Files icon.
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Elixir installs a BWCC.DLL file dated 1993 or later
in the Windows \SYSTEM directory during installation. Other programs may also install
BWCC.DLL files in different directories. Delete all
other versions of the BWCC.DLL file from your
hard disk to prevent errors.
Copying files to a diskette that is full or becomes
full may cause your PC to hang
Before copying files to a diskette, make sure
there is enough space on the diskette to copy the
selected files.
Fonts do not print correctly when proof printing
using a Windows print driver
When proof printing multiple files, your printer
may run out of memory. This may cause either incorrect fonts to be used or the printer to stop
printing.
To clear this condition, turn the printer off and
then back on. All temporary fonts are cleared
from the printer font list. Reprint your files and select the [Always] option for downloading fonts. All
Elixir fonts are removed from the printer font list
when you turn off the printer. The next time you
print, select the [Once] option to reinstall the required fonts.
Keys are not being recognized due to a nonstandard parallel port address
Modify ELIXIR\DESKTOP\SYSTEM\SYSTEM.INI
Check_Key_Port parameter with the appropriate
address below:
Check_Key_Port=DEFAULT
Check_Key_Port=LPT1
Check_Key_Port=LPT2
Check_Key_Port=LPT3
Check_Key_Port=0x278
Check_Key_Port=0x378
Check_Key_Port=0x3BC
Unless there is a problem with key checking, use
the DEFAULT option.
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No default printer available
The Elixir Desktop uses the printer(s) or print
driver(s) you set up for your Windows environment. If you did not define a default printer or print
driver in Windows, you cannot print from the
Desktop. Set up a default printer or print driver
using the Windows Print Manager and retry the
print operation.
Note that using the [Once] option to permanently
store fonts on your printer reduces available
printer memory and you may not be able to print
large graphics or files.
Using the Windows Print Manager, you can view
the fonts used by Windows. Permanent font
names are prefaced with an asterisk. When
manually adding or deleting fonts from the Windows font list, access the Windows font installer
dialog box through the Print Manager and not
through the Desktop Print dialog box [Setup] option. See your Microsoft Windows documentation
for more information.

ElixirForm
This section contains information about solving common problems you might encounter when using ElixirForm.
Cut/Copy/Paste options
Only internal text can be cut, copied and pasted,
and only by using hot keys (keyboard shortcuts).
The Edit menu Cut/Copy/Paste options will be
implemented in a future release.
Note that you can paste from the Windows Notepad, but not from a rich text format (such as
Word for Windows).
ElixirForm version 3.0 forms
Due to changes in the Elixir internal format, you
cannot use Version 3.0 forms as generated in
old-er versions of ElixirForm.
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GEM screen fonts
Screen fonts generated under the GEM environment may exhibit some quality loss in ElixirForm.
To correct this, reconvert the screen fonts using
the Desktop.
Lines attached to the outside of a box do not line
up exactly with box splits
If you want attached lines to line up exactly with
box splits, either move the box to align with the
attached line or draw the box splits as lines extending outside the box.
Maximum fonts per form
The maximum number of fonts allowed on a form
is 16.
Maximum images per form
The maximum number of images allowed on a
form is 16.
Maximum size image template
The maximum size for an image template depends on the memory currently available in
Windows.
Maximum text blocks per form
The maximum number of text blocks allowed on a
form is 32,000.
Screen retains residue from previous operations
Use the * key on the numeric keypad to refresh
your screen when residue is present.
Text on a form appears fuzzy
Text created using earlier versions of ElixirForm
may display fuzzy. Regenerate the screen fonts
for correct display.

ElixirFont
This section contains information about solving common problems you might encounter when using ElixirFont.
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Minimum and maximum Point size
The minimum supported point size is 4 points.
The maximum supported point size is 99 points.

ElixirImage
This section contains information about solving common problems you might encounter when using
ElixirImage.
Maximum file size for a graphic is exceeded
The maximum file size for a full-page graphic depends upon the available memory for Windows
(physical memory and Windows swap file size).
Dotted or dashed border widths wider than one
dot
Some Windows drivers (including VGA) do not support drawing objects (excluding lines) with dotted or
dashed border widths wider than one dot. A solid border displays regardless of your choice of border style
if your driver does not support these ElixirImage
features.

Operational and error messages
This section lists all informational and error messages
issued by the Elixir Suite for AFP products. Note that
some dialog box messages require that you to enter a
Yes or No response (such as [Continue?]).
Messages are listed alphabetically by product for the
Elixir Desktop and Converters for AFP, ElixirForm for
AFP, ElixirFont for AFP and ElixirImage for AFP.
Messages are shown in bold. Explanations for messages follow in normal text. Messages that begin with
variable parameters, such as <filename>, are listed
first within each section.
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Elixir Desktop and Converters messages
<filename> is not installed.
The selected file is not available. Copy the file to
the appropriate input directory and try the operation again.
<#> files now selected.
You have selected the number of files shown
from the current window.
* wildcard is not used correctly.
You attempted to use a DOS wildcard incorrectly.
See your DOS or Windows documentation for
proper use of wildcards.
<access> privileges are not active.
You attempted an action for which you do not
have privilege. See your system administrator for
information on user privileges.
Application requires 32-bit extensions.
You attempted to load other than a 32-bit file. See
your Windows documentation for more information.
Application was designed for a different operating
system.
You attempted to run an application using an incorrect operating system or version of the operating system.
Application was designed for MS-DOS 4.0.
You attempted to run an application using an incorrect DOS version.
A PUB file was not selected for archiving.
Select a .PUB file and retry the operation.
At bottom of list.
You have reached the bottom of the displayed file
list.
A Tool Link is not defined for this window.
You can define a tool link for a window by selecting the Tools menu [Tool Link] option while in the
window. See the Elixir Desktop and Converters
for AFP User Guide for more information.
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Attempt was made to dynamically link to a task, or
there was a sharing or network-protection er- ror.
Windows error message. See your Windows documentation for information.
Attempt was made to load a compressed executable file. The file must be decompressed before it
can be loaded.
Windows error message. See your Windows documentation for information.
Attempt was made to load a real-mode application
(developed for an earlier version of Win- dows).
The application you use must be compatible with
the loaded version of Windows. See your Windows documentation for more information.
Attempt was made to load a second instance of an
executable file containing multiple data segments
that were not marked read-only.
At top of list.
You have reached the top of the displayed file list.
Cannot back up lower than \ELIXIR.
Your user privileges do not allow you to access
directories closer to the root than the \ELIXIR
directory.
Cannot back up to a lower level.
Your user privileges do not allow you to backup
closer to the root directory.
Cannot change to a lower level directory.
Your user privileges do not allow you to backup
closer to the root directory.
Cannot change to drive <drive:>.
Specify a valid drive letter.
Cannot connect to the host. Please run RUMBA.
To enable your PC to communicate with the host,
you must execute the RUMBASP.EXE or sitecustomized command from the RUMBA Connect
dialog box accessible through the Host icon.
Cannot convert <filename> file.
The file may be corrupted or the conversion type
is not supported.
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Cannot copy a file into same UserFile directory.
You can only copy a file to another folder or duplicate it (with a different name) in the same folder.
Cannot copy input resources to output folders.
Use the Converter.
To copy a file to an Output folder, you must convert the file to the desired output format. Copy
your input file to the Converter icon and select a
format for the file. After you convert the file, it
writes to the Elixir Output folder corresponding to
its file type.
Cannot copy Elixir resources to these folders.
Elixir resources reside in Elixir folders which contain the Elixir-format appropriate for that file type.
For example, .ELX files are Elixir-format form files
stored in the Elixir Forms folder (\ELIXIR\FORMS\ELIXIR\DEMO directory).
Cannot copy files into this object.
The object (icon) to which you are attempting to
copy a file does not accept input files, or the input
file format is not the correct for that object.
Cannot copy from the Clipboard into this object.
Files in the Clipboard can only be copied to the
Jobs folder.
Cannot copy more than 5 files at a time to the
Clipboard.
Decrease the number of copies you are trying to
copy to five or less and retry the operation.
Cannot display all files. Use filter.
The maximum number of files you can display in
a window is 1600. Pull down the Filter menu from
the file folder and select [Enter Filter]. Enter a file
filter to decrease the number of files that display.
For example, enter *.EXE or the * or ? DOS
wildcards.
Cannot display the Logo.
The .BMP banner logo file specified in the Desktop Basic Setup dialog box is either corrupted or
too large to display.
Cannot enter an empty command string.
Enter a valid command for execution.
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Cannot execute an empty command.
Enter a valid command for execution.
Cannot execute <filename>.
This file is not an executable file.
Cannot find <file> to run Dispatch.
Ensure that you have specified the proper path
for the file.
Cannot find <file> to run Usertool.
Ensure you have specified the proper file path.
Cannot load Desktop icons.
Ensure you have selected the correct toolset and
attached the appropriate ElixiKey. To check or
change your toolset, select [Toolset] from the
Desktop System menu.
Cannot load Font Mapper.
Either low memory or disk space, or improper file
path specified.
Cannot load image: <filename>.
Either low memory or disk space, or improper file
path specified.
Cannot load the Logo.
The banner logo file specified in the Desktop Basic Setup dialog box is corrupted or is not in the
\ELIXIR\PICS\BMPIN directory.
Cannot load this document; file may be corrupt.
Either low memory or disk space, improper file
path specified, or corrupt file.
Cannot open <filetype>.
You either attempted to open a non-Elixir-format
file or selected a file that may be in use by another application.
Cannot open file: <filename>.
You either attempted to open a non-Elixir-format
file, selected a file that may be in use by another
application, or did not specify a file path.

A-10

ELIXIR TECHNOLOGIES CORPORATION

TROUBLESHOOTING

Cannot open temporary file.
You either specified an improper file path or did
not specify a working directory.
Cannot open the BTFONT.NAM file.
You either specified an improper file path or the
file does not exist. Copy the file to the proper directory and try the operation again.
Cannot print file: <filename>.
Either there is not enough memory or the required
fonts are missing, or you specified an improper
file path.
Cannot receive file <filename> from Host.
The utility you are using to transfer files from the
Host has failed. Ensure that the filename and
path are correct, then try the file transfer again.
Cannot save this Job. Disk may be full.
The maximum number of pages (forms) per job is
99. Ensure that you have not exceeded this maximum, or make more disk space available and try
the operation again.
Cannot save this Print Ticket. Disk may be full.
Ensure you have sufficient disk space to perform
the required operation. Make more disk space
available, then try the operation again.
Cannot send file <filename> to Host.
The utility you are using to transfer files to the
host has failed. Ensure the filename and path are
correct and try the transfer again.
Cannot use these files in the Dispatcher.
You attempted to copy a file type that is not compatible with the Dispatcher. Select a different file
type and try the operation again.
Can only open <filetype> files.
You attempted to open a non-Elixir file or a file
that is not linked to the application.
Clipboard is full.
The Clipboard can hold a maximum of 10 files.
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Close all windows first.
You attempted an operation, such as installing
software, that requires you to first close all open
windows.
Contour fonts not installed in this directory.
Contour fonts must be installed in the \ELIXIR\
FONTS\CONTOURS directory. Either reinstall
Elixir Suite for AFP or copy any Bitstream FaceLift
format contour font to this directory.
Could not build the conversion list file.
The Elixir Desktop cannot write to the .BAT file
due to disk errors or lack of disk space. Make
more disk space available and try the operation
again.
Could not copy the page: <filename>.
Either you specified an improper target directory,
the target disk is full, the file is already in use or
there is a disk error.
Could not copy the PUB file: <filename>.
Either you specified an improper target directory,
the target disk is full, the file is already in use or
there is a disk error.
Could not create the new file <filename>.
Either the disk is full or there is a disk error, or a
compatible blank file required when creating a
new Elixir format file does not exist in the \ELIXIR\DESKTOP\SYSTEM\SOURCE\ directory.
Could not create window icon for icon# <n>.
Either the disk is full or there is a disk error. Make
more disk space available and try the op- eration
again.
Could not delete directory <dirname>.
Either the directory path you specified is incorrect
or the directory you want to delete contains files.
Could not execute the application.
Either you attempted to start an application from
the Desktop for which no .BAT file exists, or there
is not enough memory to start the application.
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Could not load XAP for <filename>.
Check the User Tools user application setup by
first selecting the appropriate icon, then selecting
[Tool Props] from the Tools menu.
Could not make: <filename>.
You specified an improper directory. Check the
directory path and try the operation again.
Could not make this directory.
You specified an improper drive letter or directory
path. Check the drive letter and path, then try the
operation again.
Could not open the page: <filename>.
The Elixir page containing the names of all fonts
and images used in the form could not be read
during a .PUB file copy operation. Recreate the
.PUB file and try the operation again.
Could not open this directory.
Ensure that the path you have entered corresponds to an existing directory.
Could not open this resource window.
Ensure that the path you have entered corresponds to an existing directory.
Could not open this UserFile window.
Ensure that the path you have entered corresponds to an existing directory.
Could not receive file.
The file transfer operation you attempted has
failed. Ensure that the filename and path are correct, then try the operation again.
Could not write; disk may be full. <filename>.
Delete unneeded files on the disk to make more
disk space available.
Could not receive file
The host file transfer operation you are attempting
has failed. Ensure that the filename and path are
correct and try the operation again.
Could not write to the printer port.
Check to see what output port you have selected,
and ensure that you set it up as your printer port.
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Custom character set map does not exist.
Use a default character set map or ensure the
map you are referencing exists.
Directory <dirname> does not exist.
Ensure that the path you have entered corresponds to an existing directory.
Directory <dirname> is not empty; cannot delete.
Ensure that the directory you want to delete contains no files.
Disk could not be read.
You attempted to load a form that could not be
read due to a disk read failure. Check your disk
and, if necessary, make more space available,
then try the operation again.
Diskette is not first one in the installation set.
Begin installation with the diskette labeled "Disk 1
of #". The program requests subsequent diskettes as the installation proceeds.
Dispatcher # cannot be loaded, skipping action.
Ensure that the Dispatcher number entered corresponds to a command set up on the specified
number line in the Dispatcher.
Dispatch number must be between 1 and 12.
The Dispatcher stores up to 12 commands.
Specify the Dispatcher command line number for
the command you want (1 - 12).
Double-click to open a page.
To view a form in ElixirForm, double-click on the
form file icon.
Drive not ready or not installed.
Ensure that you have loaded a diskette in the
diskette drive you selected.
Drive %s is not removable.
The medium for the drive you selected cannot be
removed. Ensure you have selected the correct
drive.
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Dynamic-link library (DLL) file was invalid. One of
the DLLs required to run this application was
corrupt.
Windows error message. See your Windows
documentation for more information.
Elixir executable application is still running.
Wait until completion of the Elixir application before performing further operations.
ELX forms were not selected for conversion.
Select the .ELX form(s) you want to convert.
Enter a font mapping table.
For font or PSeg assignments, you must enter a
map table name in the Page Source Converter
Options dialog box.
Enter a higher value.
The value you entered is below the minimum
allowed.
Enter a lower value.
The value you entered exceeds the maximum
allowed.
Enter a name for the font.
Enter the name of the font you want to use.
Enter a 'Nickname'.
Enter a nickname for the file or application, then
try the operation again.
Enter a path to find the tool, starting with \.
Either begin the directory path with the "\" character or leave path blank to default to the \ELIX- IR
directory.
Enter a startup command.
Specify a command to execute in the User Application Setup dialog box, then try the operation
again.
Enter at least one point size.
Specify a point size for the selected font and try
the operation again.
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Enter a valid file name.
Enter a maximum eight-character stem name or
maximum three-character extension for the specified file.
Enter Data set.
You did not specify a data set in the MVS Host
Files dialog box when setting up the MVS host.
Enter resolution of 300 or Cancel.
Either cancel the operation or specify a resolution
of 300 and try the operation again.
Error deleting format.
The file format(s) you selected in the File Formats
dialog box cannot be deleted due to a disk error,
or the file is in use by another application.
Error occurred deleting file. Disk may be corrupt.
<filename>.
The file you selected cannot be deleted due to insufficient disk space or disk error. Make more
disk space available and try the operation again.
Error opening output file: <filename>.
Your copy operation failed due to insufficient disk
space or disk error. Make more disk space available and try the operation again.
Error opening source file: <filename>.
Your copy operation failed due to insufficient disk
space or disk error. Make more disk space available and try the operation again..
Error opening window.
Your operation failed due to insufficient disk
space or disk error. Check your disk for errors, or
make more disk space available and try the operation agai..
Error reading Host.
Execute the RUMBA command again to convert
to the host. You can access the RUMBA Connect
dialog box through the Host icon.
Error renaming file: <filename>.
Ensure that the filename you enter complies with
standard file naming conventions.
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Error: Resource file not found.
Check the path specified for the location of the resource file.
Error writing PostScript font map.
Your PSFONTS.MAP file may be corrupt, or you
may have specified an incorrect directory path.
Executable file was invalid. Either it was not a
Windows application or there was an error in the
.EXE image.
Windows error message. See your Windows documentation for more information.
Failed to allocate memory.
The Desktop was unable to allocate the additional
memory as requested. Either the memory address block you specified is in use or you need to
have more memory available.
Failed to link to <filename>.
Ensure that the path and filename you enter is
correct.
<filename> is not installed.
Copy the file to the appropriate input directory and
try the operation again.
Files skipped.
During a delete, duplicate, or copy operation, you
specified exclusion of one or more files.
Files have not been selected.
Select the files for which you want to perform an
operation, then try the operation again.
Files were not selected for running the
Dispatcher.
To run a command from the Dispatcher, you must
copy a file to the Dispatcher command line containing the command you want to execute. If you
selected the [Prompt for parameters] option in the
User Application Setup dialog box while setting up
the Dispatcher command, you must specify a file
as a parameter. You can then drag and drop the
file on the appropriate Dispatcher command line.
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File was not found.
Ensure that the path and filename you enter is
correct.
Font <filename> is not mapped.
The program cannot map the Elixir font you are
converting to screen, Windows or HP PCL format
because it is missing the .GL1 or .GL0 component files.
Form is removed from the Clipboard.
The Clipboard can temporarily store form files for
use in jobs. When you move a form from the
Clipboard to the job you are creating, the form no
longer exists on the Clipboard.
Form not loaded.
The form file you selected could not be loaded to
complete the desired operation.
Horizontal Offset out of range.
The horizontal floating offset value you entered in
the AFP Page Converter Options dialog box must
be between 0 and 32000.
Host not connected.
You must enter the RUMBADSP.EXE command
(or other site-specific command) to execute
RUMBA before connecting to a host. You can access the RUMBA Connect dialog box through the
Host icon.
Ignoring unknown command: <filename>.
Ensure that the command you enter is an executable file, that it is referenced by its correct file
name, and that it resides in the directory specified.
Image too large to convert.
When converting an Elixir .LP3 image to a .LGO
image, the maximum size .LGO you can create is
128K.
INSTALL.LOG file was not found.
The program cannot find the INSTALL.LOG file in
drive:\ELIXIR. Reinstall software.
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Invalid files were selected for conversion.
Only files in supported formats are convertible to
other supported formats. Ensure the program
supports the format of the file you want to
convert.
Invalid files were selected for transforming.
Only files in supported formats are transformable
to other supported formats. Ensure the program
supports the format of the file you want to
convert.
Logo is too large.
The .BMP logo file you specified in the Desktop
Basic Setup dialog box to display when the Desktop loads is too large to display. Select a smaller
.BMP file to display, or reduce the logo file size
using the ElixirImage or other graphics
application.
LP3 files were not selected for conversion.
Select a .LP3 file or files and retry the operation.
Match not found.
No files match the filter you entered.
No property sheet available for this converter.
There is no default property sheet for setting up
options for the converter. Select the options you
want at the time of conversion.
Not enough memory available for Desktop.
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit Windows and start Windows again.
Not enough memory available for file list. Exiting.
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit Windows and start Windows again.
Not enough memory available for this form.
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit Windows and start Windows again.
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Not enough memory available to copy.
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit Windows and start Windows again.
Not enough memory available to copy files.
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit Windows and start Windows again.
Not enough memory available to create window.
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit Windows and start Windows again.
Not enough memory available to define windows.
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit Windows and start Windows again.
Not enough memory available to perform Loader
operations.
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit Windows and start Windows again.
Not enough memory available to select files.
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit Windows and start Windows again.
Number of copies must be between 0 and 255.
The value you enter in the Page Source Converter Options dialog box option must be between
0 and 255.
Number of objects selected: <n>
You have select n files in the current directory.
Offset X for A3 must be a number from 0 to 4962.
Enter a number between the minimum and maximum allowable values.
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Offset X for 11x17 must be a number from 0 to
5100.
Enter a number between the minimum and maximum allowable values.
Offset X of page one has to be less than page two.
Enter an offset value that is less than the offset
value for page two..
Offset Y for A3 must be a number from 0 to 3508.
Enter a number between the minimum and maximum allowable values.
Offset Y for 11x17 must be a number from 0 to
3300.
Enter a number between the minimum and maximum allowable values.
Only Forms, Fonts, Graphics, or Documents can
be converted.
You cannot perform conversion operations on
other than form, font, image, or document files.
Only Forms, Fonts, Graphics, or Documents can
be transformed.
You cannot perform transformation operations on
other than form, font, image, or document files.
Only .ELX forms can be copied to the Clipboard.
The Clipboard temporarily stores form files during
job creation. Jobs contain Elixir-format (.ELX)
files only.
Only .ELX forms can be copied to the Job window.
Jobs are composed of pages, or forms, which are
.ELX Elixir-format form files.
Only ELIXIR-format files can be edited.
You cannot open or edit non Elixir-format files using any of the Desktop applications.
Only ELIXIR-format files can be opened.
You cannot open or edit non Elixir-format files using any of the Desktop applications.
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Only one * wildcard character can be used in an
MVS dataset.
You must specify only one wildcard character.
See your Windows documentation for more information.
Outline fonts not installed in this directory.
The program installs Outline fonts (Efont Factory
fonts) in the \ELIXIR\FONTS\CONTOURS directory. You can access this directory by opening
the Fonts folder, then Input Fonts, then Outline
Fonts folder.
Page not in given directory.
Recheck the page (form) file name for accuracy,
and confirm that the path name you entered is
correct.
Path was not found.
Recheck the path name you entered for validity.
Pick an icon for copy destination.
Click on the icon into which you want to copy the
file. For Elixir folders, the file remains attached to
the cursor until you click on the inner folder which
represents the file format of the attached file.
Point size must be in the range 2 to 50.
Enter a number between the minimum and maximum allowable values.
Point size must be in the range 2 to 99.
Enter a number between the minimum and maximum allowable values.
Printer form feed did not operate.
Check your printer to ensure you turned it on and
it is in the proper mode for form feed operations.
Publication File copy is canceled.
The PUB file copy operation canceled as
requested.
Qualifier is empty.
The data set name you specified has an empty
qualifier between dots. You can access data sets
through the Host icon.
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Qualifier xxxx is too long (8 characters are
allowed).
The data set name you specified contains a qualifier that exceeds the 8 character limit. You can
access data sets through the Host icon.
Removing page from the Job.
The form (page) file you specified for deletion is
being removed from the job.
Scheduler Actions not saved. Disk may be full.
Delete any unnecessary files to create more
space on the current disk.
Scheduler Actions not started.
The Desktop cannot allocate the memory required for the selected operation. Close any applications you are not currently using and try the operation again.
Scheduler Action support is not installed.
See your System Administrator for more information.
Select a file for printing.
Select a file before starting the current print operation.
Select a form from the Clipboard.
Select a form from the Clipboard and copy it to
the selected folder.
Select at least one .ELX form to be included in the
Pub File.
A .PUB file must contain at least one form.
Select a UserTool first.
Select a user tool before starting the current
operation.
Select contour(s) and copy to the Converter.
Select a contour (outline) font from the \ELIXIR\FONTS\CONTOURS folder to copy to the
Converter icon.
System was out of memory, executable file was
corrupt, or relocations were invalid.
Windows error message. See your Windows documentation for more information.
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Testing for Scheduler Action <n>.
The Scheduler is in processing mode searching
for the specified action to perform.
The file already exists: <filename>.
You can overwrite the existing file, or rename the
file you are copying or duplicating to avoid overwriting the existing file.
There is no input folder for this resource.
The format of the file you are copying is not a
supported format.
There was insufficient memory to start the
application.
Close any applications you are not working with
and try starting the application again. If you receive the same memory error again, close further
applications or exit Windows and start Windows
again.
This directory does not exist.
Confirm that the directory path you entered is correct, or create the missing directory using the
System menu [Make directory] option.
This document file is empty.
There are no form (page) files referenced within
the document file. Edit the ASCII-format .DAT
document file to list the forms you want included
in the document, or copy form files to the document file icon.
This icon cannot be opened.
The program uses some Desktop icons for setting properties only. Click on the icon with the
right mouse button to view or set its properties.
This is not an DOS-Elixir diskette.
To format a diskette as a DOS-Elixir diskette,
open the Diskette icon, and with a diskette in the
selected diskette drive, select [DOS Elixir] as the
[Diskette Type] option, then select [Perform FORMAT] as the [Diskette Access] option.
This name is reserved by DOS.
Rename the file for which you received the error.
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This Print Ticket is empty.
Specify printing options by selecting print ticket
options or entering information in the print ticket.
To access the print ticket, open the job and
double-click on the PrTicket icon for the job.
Click on [OK] in the Page Imposition Options dialog box (if applicable) to display the Job Print
Ticket dialog box.
This object has no properties.
There is no default property set-up dialog associated with the icon you clicked on.
This UserTool has not been defined.
To set the properties for a user tool, right-click on
the User Tool icon or select [Tool Props] from the
Tools menu when the icon is selected. Specify
the icon properties in the User Application Setup
dialog box that displays.
Tool not found.
Check the User Tools folder to ensure that the
tool exists.
Transformer utilities not installed.
You need to install stand-alone utilities before you
can perform transform operations.
Type of executable file was unknown.
Common executable file extensions are .EXE,
.BAT, and .COM. Ensure that the file you are
specifying is an executable file.
Unknown command: <filename> ignoring.
Ensure that the filename and path you specify for
the command are valid, and that the command is
an executable file.
User-defined printer is not set up.
You need to set up your printer options by clicking
on the [Setup] button in the Printer dialog box before you can print to a printer.
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Usertool: <filename> does not exist.
Check the properties of the user tool in the User
Tools folder by right-clicking on the icon. Ensure
that the information entered in the User Application Setup dialog box is correct. You can use the
[Browse] button in the dialog box to check the directory paths and filenames you enter.
Usertool: <file.XAP> cannot be loaded, skipping
action.
Check the properties of the user tool in the User
Tools folder by right-clicking on the icon. Ensure
that the information entered in the User Application Setup dialog box is correct. You can use the
[Browse] button in the dialog box to check the directory paths and filenames you enter.
Vertical Offset is out of range.
The vertical floating offset value you entered in
the AFP Page Converter Options dialog box must
be between 0 and 32000.
Warning: Can not create LOG file <filename>.
The log file name you specified in the Message
Options dialog box is invalid. Enter another file
name and ensure that it has a .LOG extension.
file.

<filename>
Ensure that you have specified the correct filename and path, and that the file you want to update is not read only.

Warning: Could not open <filename>.
You can open or edit only Elixir-format form, font,
and image files within the Desktop via their corresponding applications. You can also open and
view text or ASCII-format files using a text editor
through the Dispatcher or a DOS command. Ensure that you have entered a valid filename and
path.
Warning: Disk space is less than <n> KB.
You have reached the low disk space threshold
you specified in the Desktop Basic Setup dialog
box. You should delete unnecessary files to create more disk space, or lower the specified
threshold, if practical.
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Warning: Drive <drive:> is not available.
Specify an available drive or wait until a busy
drive becomes available.
Warning: \ELIXIR\DESKTOP.INI is corrupted.
Back up your GEM files, delete GEM files from
drive:\ELIXIR, and resinstall software.
Warning: Missing ElixiKey for the <toolname>
Toolset; conversions not possible.
You must have the proper ElixiKey installed to
perform this file conversion. Connect the proper
ElixiKey to the LPT1 parallel port of your PC. To
view the ElixiKey(s) attached to your PC, click on
the [Show installed ElixiKeys] option in the Desktop Diagnostics dialog box.
For information on the correct ElixiKey, contact
your customer support representative.
Warning: Zero length file detected:
action.
File has no bytes. Recreate file.

Retrying

Windows version was incorrect.
Windows error message. See your Windows
documentation for more information.
Working directory does not exist.
Ensure that the path you have entered for the
command to execute is the correct path, and that
the executable resides in the specified directory.
ElixirForm messages
<element> - filtered out.
You attempted to select an element excluded (set
to OFF) in the Selection Group Filter.
All <element type(s)> elements will be deleted. OK
to delete?
More than one element is on the form and you attempted to delete all elements using <Ctrl> +
<Del>.
All colors are being used: Cannot be deleted.
You attempted to delete one or more colors from
the local palette, all of which you used on the
form.
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All elements in the group will be deleted. OK to
delete?
This message requests confirmation for deleting
all elements in the selected group.
All patterns are being used: Cannot be deleted.
You attempted to delete all unused patterns from
the local pattern palette (by pressing <Ctrl> +
<Del>) and you used all patterns on the form.
Autosave ...
This message momentarily displays during form
autosave.
B&W mode. Color display toggle ignored.
This message displays when a black and white
form is loaded and you press <Alt> + <F9>.
BPSD tags are hidden.
Boilerplate Space Definition Tags (used by
DocuMerge for specifying variable data) do not
display in text. You can toggle between Hide and
Display data tags using <Ctrl> + <T>.
BPSD tags are shown.
Boilerplate Space Definition Tags (used by
DocuMerge for specifying variable data) display in
text. You can toggle between Hide and Display
data tags using <Ctrl> + <T>.
Cannot delete any predefined patterns.
You attempted to delete one of the predefined
patterns (hollow, light gray, medium gray, dark
gray, or black) from the local pattern palette.
Cannot load the keyboard mapping table.
The requested .KMP file is corrupt. Check your
.KMP file. See the Elixir Desktop and Converters
for AFP User Guide for information about .KMP
files.
Cannot load form.
A software error occurred when attempting to
load the requested form (one or more files may
be corrupt). Retry the operation.
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Cannot read from disk.
A software error occurred when attempting to
read from the disk (one or more files may be corrupt), or you specified an empty diskette drive.
Retry the operation.
Could not create element.
A software error occurred when attempting to create the requested element (disk may be full). Retry the operation.
Could not duplicate the element.
A software error occurred when copying the selected element. Retry the operation.
Could not open AUTOBACK.ELX file.
A software error occurred when trying to load the
AUTOBACK.ELX backup form file. Retry the
operation.
Could not open output page file.
This message displays when DOS is unable to
open a file to which you want to save a form.
This occurs when you attempt to save a form and
either the disk is full or the target file is on a diskette that is write-protected.
Could not open the form: <filename>
A software error occurred when loading the selected form or the form file was corrupt. Retry the
operation or check the form.
Could not write AUTOBACK.ELX file.
A software error occurred when trying to write the
backup file, AUTOBACK.ELX. Check available
disk space.
Could not write form to disk.
A software error occurred when attempting to
save the form. Check for sufficient disk space.
Retry the operation.
Decimal point is not allowed.
Entering a decimal point in the field (numeric box)
is not allowed, retry entering a number without a
decimal point.
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Default font not found in \ELIXIR\FONTS\SCREEN
subdirectory. Form not loaded .
When loading a form that does not contain any of
the fonts in the current font list, ElixirForm attempts to substitute a default font from the above
directory. If a default font is not found, the form
does not load and the above message displays.
Check your hard disk capacity and reinstall
ElixirForm.
Error: Duplicate font:
You attempted to replace a font in the font list
with a font already specified in the font list. Delete the second instance of the font.
Error occurred when loading font: <filename>
A software error occurred when attempting to
load the requested font. The requested font file
may be corrupt.
Font List: <filename> already exists Overwrite ?
You attempted to save a font list file with an existing filename. Retry the operation with another
filename if you do not want to overwrite the existing file.
Font list is empty. Cannot add text.
Add one or more fonts to the font list before attempting to add text to the form.
Form name: <filename> already exists. Overwrite?
You attempted to save a form with an existing filename. Retry with another name. Retry the operation with another filename if you do not want to
overwrite the existing file.
Form name: <filename> has not been saved.
Save?
You attempted to exit ElixirForm or load another
form before saving the current one.
Form name: <filename> will be deleted.
This message requests confirmation for deleting
the selected form.
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GEM text formatting mode. <CR> disabled if wrap
is ON.
When you select [GEM] as the [Text Formatting
Compatibility] option in the Text and Font Options
dialog box, you disable the <Enter> key if word
wrap is set to ON.
Importing text: <filename> position - free.
Text from the specified file is being imported in
"free text" mode. Press <Ctrl> + <I> or <F11> to
toggle to "locked text" mode.
Importing text: <filename> position - locked.
Text from the specified file is being imported in
"locked text" mode. Press <Ctrl> + <I> or <F11>
to toggle to "free text" mode.
Loading configuration file ...
This messages momentarily displays when first
starting ElixirForm. The configuration file stores
your system settings for the next time you start
ElixirForm when you select [Save Configuration]
from the System menu.
Loading ink patterns...
This informational message displays when loading inks patterns.
Lower range limit has been reached.
You attempted to enter a number in a field (numeric display box) that is too small. Backspace
to clear the entry field and enter a larger number.
Missing or insufficient ElixiKey.
You must have the proper ElixiKey installed to
perform this file conversion. Connect the proper
ElixiKey to the LPT1 parallel port of your PC. To
view the ElixiKey(s) attached to your PC, click on
the [Show installed ElixiKeys] option in the Desktop Diagnostics dialog box. For information on
the correct ElixiKey, contact your customer support representative.
Negative value is not allowed.
You attempted to enter a negative value in a field
(numeric display box) that disallows it. Retry with
a positive value.
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No image selected.
You did not select an image for pasting in the
form. Select an image and try again.
No text was selected.
You attempted to perform an operation on text
without first selecting the text.
One <element type> element will be deleted. OK to
delete?
You attempted to delete all form elements by
pressing <Ctrl> + <Del> and the form contains
only one element.
Only two decimal places are allowed.
You attempted to enter more than two decimal
places in a field (numeric display box). Retry with
two decimal places or less.
Open the text element first.
You attempted to use the soft keyboard without
first clicking in the form work area to position text.
Pattern is being used: Cannot be deleted.
You attempted to delete a pattern which is in use
on the form from the local pattern palette.
Replace font <filename> with <filename>?
You attempted to replace a font in the font list
with a new font.
Saving configuration file ...
This message displays momentarily when selecting [Save Configuration] from the System menu.
The message also displays when you select
[Save State on Exit] in the Usage Switches dialog
box (displayed from the System menu) and then
exit ElixirForm.
Sticky Lines is set to OFF.
The Sticky Lines feature is off. Press <Ctrl> +
<L> to toggle sticky Lines on.
Sticky Lines is set to ON.
The Sticky Lines feature is on. Press <Ctrl> +
<L> to toggle sticky Lines off.
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Text box is bigger than the page size.
You specified a text box that exceeds the page
dimensions. Reduce the text box size.
Text box size is below allowed limit.
The lower limit for text box width and height is
zero. Increase the size of the text box.
Text import position - free.
This informational message displays when importing text in "free text" mode. Press <Ctrl> +
<I> or <F11> to toggle to "locked text" mode.
Text import position - locked.
This informational message displays when importing text in "locked text" mode. Press <Ctrl> +
<I> or <F11> to toggle to "free text" mode.
The font path does not exist.
You attempted to specify a non-existing path for
the Fonts directory in the Filing Options dialog
box.
The form path does not exist.
You attempted to specify a non-existing path for
the Forms directory in the Filing Options dialog
box.
The text path does not exist.
You attempted to specify a non-existing path for
the Text directory in the Filing Options dialog box.
This file is not an ELX form or is corrupted.
A software error occurred when loading the form.
Ensure the form is an Elixir-format form.
Too many decimal places...
You specified too many decimal places in a field
(numeric display box). Retry with fewer decimal
places.
Upper range limit has been reached.
Enter a smaller number in the numeric display
box.
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Warning: Font list contains default fonts. Save
anyway?
This warning message displays when a default
font replaces the missing screen font and you attempt to save the form. Save the file with a new
name so that the original font name is retained in
the font list of the original form.
Warning: Objects exceeding the page size will be
lost. Continue anyway?
You decreased the page size (in the Page Properties dialog box), and some objects exceed the
new page boundary. You may continue (and lose
the exceeding objects) or cancel the page format
change.
ElixirImage messages
<filename> has not been saved. Continue anyway?
You are closing an image file without saving the
changes to the file. To save the current image,
pull down the File menu and select [Save] or
press <Ctrl>+<S>.
BLACK & WHITE image.
A black-and-white image is currently loaded.
Block copied to clipboard.
The image or image area is copied and placed in
the Windows Clipboard leaving the original image
or image area unchanged. To paste the image or
image area, pull down the Edit menu and select
[Paste] or press <Ctrl> + <V>.
Block deleted.
The image area you marked for deletion was
deleted.
Block inserted.
The image or image area in the Windows Clipboard displays in your image.
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Block moved to clipboard.
The image or image area is cut and placed in the
Windows Clipboard leaving a blank space in
place of the image or image area. To paste the
image or image area, pull down the Edit menu
and select [Paste] or press <Ctrl> + <V>.
Building reduced view ...
Your image reduces. To restore your image to the
original size click on the up arrow in the Toolbar
Zoom icon or press <+>.
Cannot allocate cut view ...
There is not enough memory to perform the selected operation. Close any applications you are
not working with and try the operation again. If
you receive the same memory error again, close
further applications or exit Windows and start
Windows again.
Cannot break up the image.
The number of Horizontal and/or Vertical pieces
you specified in the Breakup Image dialog box is
too high. Reduce the number of pieces specified
and try the operation again.
Cannot create %s font files to save to.
Either you must first load the font into which you
want to tile the image or the current disk may be
full. Delete any unnecessary files and try the operation again.
Cannot create .TXT file for writing in text.
There is not enough memory to perform the selected operation. Close any applications you are
not working with and try the operation again. If
you receive the same memory error again, close
further applications or exit Windows and start
Windows again.
Cannot create form trace-over template.
The image is too large. Close any applications
you are not working with and try the operation
again. If you receive the same memory error, either exit and restart Windows or reduce the size
of the image (using the Resize transformation operation) and try the operation again.
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Cannot create screen version.
The image is too large. Close any applications
you are not working with and try the operation
again. If you receive the same memory error, either exit and restart Windows or reduce the size
of the image (using the Resize transformation operation) and try the operation again.
Cannot distort area (not enough memory).
The image is too large. Close any applications
you are not working with and try the operation
again. If you receive the same memory error, either exit and restart Windows or reduce the size
of the image (using the Resize transformation operation) and try the operation again.
Cannot load an image, leaving ..
There is not enough memory to load the current
image. Close any applications you are not working with and try the operation again. If you receive
the same memory error, close further applications
or exit Windows and start Windows again.
Cannot load font %s.
Ensure that you have specified a font filename
that exists, then close any applications you are
not working with and try the operation again. If
you receive the same memory error, close further
applications or exit Windows and start Windows
again.
Cannot load image %s.
There is not enough memory to load the selected
image. Close any applications you are not working with and try the operation again. If you receive
the same memory error, close further applications
or exit Windows and start Windows again.
Cannot mirror area (no memory).
The image is too large. Close any applications
you are not working with and try the operation
again. If you receive the same memory error, either exit and restart Windows or reduce the size
of the image (using the Resize transformation operation) and try the operation again.
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Cannot resize bitmap (not enough memory).
The image is too large. Close any applications
you are not working with and try the operation
again. If you receive the same memory error, either exit and restart Windows or reduce the size
of the image (using the Resize transformation operation) and try the operation again.
Cannot rotate bitmap (not enough memory).
The image is too large. Close any applications
you are not working with and try the operation
again. If you receive the same memory error, either exit and restart Windows or reduce the size
of the image (using the Resize transformation operation) and try the operation again.
Cannot white out area (area was not selected).
You selected the [Outside area] option when performing the Clear transformation operation and
have not selected an area. Select an image area
by dragging the mouse, and try the operation
again.
Clear operation failed.
There is not enough memory to perform the Clear
operation. To clear inside or outside a selected
image area you must first select the image
area.Close any applications you are not working
with and try the operation again. If you receive
the same memory error, close further applications
or exit Windows and start Windows again.
Clipboard is empty.
There is nothing in the Windows Clipboard to
paste.
Copying image tile ...
A tile is being copied to your image.
Could not print.
The image is too large, or the target printer is out
of paper, turned off, or not designated.
Could not save image %s to disk.
There is not enough disk space on the current
disk. Delete any unnecessary files to create more
disk space on the current disk.
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Could not save the font; disk may be full.
There is not enough disk space on the current
disk. Delete any unnecessary files to create more
disk space on the current disk.
Creating default image ...
The image you want to create cannot be created
due to size or a missing parameter. A default image generates instead.
Change the height and width values in the Image
Attributes dialog box and ensure you have entered all option values for which you do not want
the default value used.
Creating temporary file ...
The file created is for the current session of ElixirImage only.
Debolden operation failed.
There is not enough memory to perform the
Lighten operation. Close any applications you are
not working with and try the operation again. If
you receive the same memory error again, close
further applications or exit Windows and start
Windows again.
Decimal point is not allowed.
Enter a value without a decimal point and try the
operation again.
Drawing is not supported at reduced view.
You cannot use the drawing tools while in a reduced view. Click on the up arrow, in the Toolbar
Zoom icon, until the image displays at 1X magnification and try the operation again.
ElixiKey not detected. Cannot save files, print images or load data into clipboard.
You did not connect your ElixiKey to the parallel
port (LPT1) of your PC. Connect your ElixiKey to
the parallel port and try the operation again.
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Embolden operation failed.
There is not enough memory to perform the
Darken operation. Close any applications you are
not working with and try the operation again. If
you receive the same memory error again, close
further applications or exit Windows and start
Windows again.
Error occurred when creating temporary disk image.
There is not enough memory to perform the selected operation. Close any applications you are
not working with and try the operation again. If
you receive the same memory error again, close
further applications or exit Windows and start
Windows again.
Error saving Logo Control Text file.
The current disk may be full. Delete any unnecessary files to create more disk space on the current disk and try the operation again.
File %s already exists. Overwrite?
The file you are trying to save already exists. If
you do not cancel your save operation, the existing file is overwritten.
Filter operation failed.
There is not enough memory to perform the Filter
operation. Close any applications you are not
working with and try the operation again. If you
receive the same memory error again, close further applications or exit Windows and start Windows again.
Font %s has not been saved. Save?
Select [Yes] if you have edited a font and want to
save your changes. Select [No], if you do not
want to save your changes.
Halftone operation failed.
There is not enough memory to perform the Halftone operation. Close any applications you are
not working with and try the operation again. If
you receive the same memory error again, close
further applications or exit Windows and start
Windows again.
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Image %s already exists. Overwrite?
The image you want to save already exists. Select [Yes] if you want to overwrite the existing image. Select [No] if you do not want to overwrite
the existing image.
Image %s does not exist.
The image you are trying to load does not exist.
Ensure that the filename is correct and try the operation again.
Image %s has not been saved. Save?
Select [Yes] to save the current image. Select
[No], if you do not want to save the current image.
Image name is required.
Creating a new image requires you to specify an
image name in the Image Attributes dialog box.
Image size will exceed available memory.
The image size specified in the Image Attributes
dialog box is too large. Specify smaller height
and width sizes and try the operation again.
Image width and height must be non-zero.
Image width and height must be a positive number. Enter positive numbers for width and height
in the Image Attributes dialog box and try the operation again.
Insufficient memory, aborted ..
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit Windows and start Windows again.
Invert operation failed.
There is not enough memory to perform the Invert
operation. Close any applications you are not
working with and try the operation again. If you
receive the same memory error again, close further applications or exit Windows and start Windows again.
Loading configuration file ...
Default settings for ElixirImage are being loaded.
Loading Elixir font file ...
The font file you selected is being loaded.
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Loading Pattern files ...
The pattern file you selected is being loaded.
Lower range limit reached.
You attempted to enter a number in a field (numeric display box) that is too small. Backspace
to clear the message and enter a larger number.
Moving image tile ...
The image tile you selected is being moved.
Negative value is not allowed.
The value specified cannot be negative. Specify
a positive value and try the operation again.
Not a simple image object, use Overlay conversion instead.
Move the page segment(s) to the input forms
folder (\ELIXIR\FORMS\OVEIN) and convert to
Elixir form format (.ELX). Ensure the [Remove
White Space] option is set to 'No', then convert
the .ELX to image using the Form converter.
Not enough memory is available to create image
%s.
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit Windows and start Windows again.
Not enough memory to change image format.
Transform operation in progress ..
Close any applications you are not working with
and try the operation again. If you receive the
same memory error again, close further applications or exit Windows and start Windows again.
Outline operation failed.
There is not enough memory to perform the Outline operation. Close any applications you are
not working with and try the operation again. If
you receive the same memory error again, close
further applications or exit Windows and start
Windows again.
Performing zoom operation ...
The current image is being magnified.
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Printing canceled.
The program canceled your print operation.
Resetting image to last saved version .. Continue?
Select [Yes] to undo all edits since the last save
operation. Select [No] if you do not want to undo
all edits since the last save operation.
Saving configuration file ...
All the settings in the current session of ElixirImage are being saved as defaults to a configuration file.
Select any screen area using the mouse.
Drag the mouse to select an area to paste to the
Windows Clipboard.
Shift operation failed.
There is not enough memory to perform the Shift
operation. Close any applications you are not
working with and try the operation again. If you
receive the same memory error again, close further applications or exit Windows and start Windows again.
There is nothing to redo.
You did not perform a previous operation which
you can redo.
There is nothing to undo.
You did not perform a previous operation which
you can undo.
This font was loaded in read-only mode.
You tried to copy an image area into a currently
loaded font/clipart library set using the Import
transformation operation.
Select the Export
transformation operation and try the operation
again.
This function is supported at 1X magnification
only.
Use the up or down arrows in the Toolbar Zoom
icon to display your image at a 1X magnification
and try the operation again.
Too many decimal places.
Enter a number with fewer decimal places.
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Transformation completed.
The program completed the transformation operation you selected.
Unexpected change of toolset. Stop editing and
reload the image.
Reload the image and try the operation again.
You cannot change toolsets in the Elixir Desktop
and Converters for AFP during an editing or creation session in an Elixir application.
Upper range limit reached.
You attempted to enter a number in a field (numeric display box) that is too big. Backspace to
clear the message and enter a larger number.
ElixirFont messages
<Transform operation name> the whole font ?
This message requests confirmation for transforming the entire font.
Area is outside the cell
This message displays in Edit Bitmap mode when
you press <Enter> after using the <Shift> +<arrow> keys and moves the Move or Copy Area box
outside the character cell.
Area was copied to the clipboard.
The selected area copied to the Clipboard.
Area was deleted.
The selected area was deleted.
Bitmap was copied to the clipboard.
The character bitmap copied to the Windows
Clipboard.
Bitmap was cut and saved to the clipboard.
You did not select an area, so the whole character bitmap was cut and saved to the Windows
Clipboard.
Bitmap was deleted.
The character bitmap deleted (undo restores this
operation).
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Bitmap was inserted from the clipboard.
The character previously saved to the Windows
Clipboard copied to the currently displayed character cell.
Blend submode.
You selected the Blend tool.
Buffer is full
You attempted to insert more than 1024 characters in the sampling pad. The character limit for
the sampling pad is 1024.
Cannot blend with a blank character.
While in Edit Bitmap mode, you attempted to
blend a character with a NULL or a SPACING
character.
Cannot copy a character onto itself.
You attempted to copy a selected character to the
same character position.
Cannot cut or copy the selected area.
A software error occurred during a Windows cut
or copy to Clipboard operation.
Cannot embolden a blank character.
You attempted to embolden a NULL or a SPACING character.
Cannot filter a blank character.
You attempted to filter a NULL or a SPACING
character.
Cannot halftone a blank character.
You attempted to apply halftoning to a NULL or a
SPACING character.
Cannot load character bitmaps for the font name.
The font file name you are trying to load is corrupt
or one or more components are missing.
Cannot load .HDR or .GLH files for the character
set name
The .HDR or .GLH files for the specified character
set are either missing or corrupt. Try reinstalling
the font.
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Cannot load .HDR or .GLH files for the font name
The .HDR or .GLH files for the specified font are
either missing or corrupt. Try reinstalling the font.
Cannot mirror a blank character.
You attempted to mirror a NULL or a SPACING
character.
Cannot open a source file for merging.
A software problem is preventing loading the second (source) font for merging. The source font
may be corrupt or have one or more components
missing. Try reinstalling the font.
Cannot open sampling pad.
A software error is preventing opening the sampling pad. Exit ElixirFont and retry the operation.
Cannot open the Edit Bitmap window.
A software error has occurred that is preventing
opening the Edit Bitmap Window. Retry the operation, or exit and restart ElixirFont.
Cannot paste the selected area
An error occurred in the Windows Clipboard
paste operation. Retry the operation, or exit and
restart ElixirFont.
Cannot rotate a blank character.
You attempted to rotate a NULL or a SPACING
character.
Cannot shift a blank character.
You attempted to shift a NULL or a SPACING
character.
Cannot slant a blank character.
You attempted to slant a NULL or a SPACING
character.
Cannot start Edit mode.
A software error is preventing ElixirFont from entering Edit Bitmap mode. Exit and restart ElixirFont and retry the operation.
Cannot swap a character with itself.
You attempted to swap a selected character with
itself.
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Changes cannot be undone.
You attempted to undo an operation that cannot
be undone.
Char is not printable.
You pressed a non-character key (for example,
the <Tab> key), or click edon a NULL character
while in the sampling pad.
Character <XX> may extend beyond the boundaries of its cell. E(xtend), S(kip), or A(bort)?
During a font transformation, a transformed character may be larger than its cell. You need to extend the character cell, skip the transformation for
the specified character, or abort the entire
transformation.
Characters blended, click on POST to save.
Characters successfully blended.
Character Blending error:
A software problem occurred during the creation
of a new blended bitmap (in Edit Bitmap mode).
Check disk space and retry the operation.
Character bitmap is corrupted.
Transforming or editing corrupted the character
bitmap. Retry the operation.
Character corrupted during transform.
Transforming or editing corrupted the character or
record. Retry the operation.
Character emboldening failed for Char #
Emboldening the character resulted in the character using more than 4K of memory (4K is the
character limit). Reduce the size of the original
bitmap.
Character has changed. Do you want to exit without posting changes?
You edited a character in Edit Bitmap mode and
attempted to exit Edit Bitmap mode before posting your changes.
Character is already NULL!
You attempted to create a NULL character from
another NULL character.
A-46

ELIXIR TECHNOLOGIES CORPORATION

TROUBLESHOOTING

Character is corrupted; cannot be transformed.
The character bitmap or record is corrupt. Retry
the operation.
Character resizing failed for Char #
Resizing the character resulted in the character
using more than 4K of memory (4K is the character limit). Reduce the size of the original bitmap.
Character rotation failed for Char #
A software problem occurred during the creation
of a new rotated bitmap. Retry the operation.
Character slanting failed for Char.
A software problem occurred during the creation
of a new slanted bitmap. Retry the operation.
Choose the location to swap with.
You selected a character for swapping and must
now choose a second character.
Choose the target location to copy to.
You already selected source characters and must
now click on a target character.
Click on characters and move to blend.
This message displays in Edit Bitmap mode when
blending characters to inform you that both characters are displayed in the framing window.
Click on the character in the window.
You clicked outside of cell frame in the framing
window.
Could not load screen font. Exiting..
A software error prevented loading the selected
font. Reload ElixirFont and retry the operation, or
regenerate the screen font in the Desktop.
Could not load screen font <fontname>
The .FNT or .WDT components of the SYSL and
SYSH fonts (used to display screen messages in
low resolution and high resolution modes) in
drive:\ELIXIR\DESKTOP are corrupt. Check for
available disk space and reinstall ElixirFont.
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Could not read <name .KMP> file
A software problem occurred when attempting to
read the .KMP file or the .KMP file could not be
found.
Current loaded font has not been saved. Save?
The font was changed and you want to load a
new font or exit ElixirFont before posting the
changes.
Decimal point is not allowed.
Entering a decimal point is not allowed for the
current entry box. Retry the operation without a
decimal point.
Delete selected characters? - Confirm deleting of
selected chars.
This message requests confirmation for deleting
one or more selected characters.
Device key checking
ElixirFont is checking for the correct ElixiKey.
ElixiKey not detected; cannot save files.
You did not connect the correct ElixiKey to the
LPT1 parallel port and you cannot save edited
files. Connect the correct ElixiKey to the parallel
port.
Enter value higher than <value>
The number entered is too low, enter a number
higher than the value displayed in the message.
Enter value lower than <value>
The number entered is too low, enter a number
lower than the value displayed in the message.
Error occurred during reformatting.
An error occurred when transforming the font.
Retry the operation.
Error occurred in reversing this character.
A software error occurred. Retry the reversing
operation.
Error occurred in underlining this character.
A software error occurred. Retry the underline
operation.
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Error occurred saving GLY file.
ElixirFont cannot save the .GLY component of the
font file. Retry the operation.
Error occurred when blending character #
A software error occurred in Edit Bitmap mode.
Retry the character blending operation.
Error occurred when changing the font resolution.
A software error occurred. Try changing the font
resolution again.
Error occurred when emboldening this character.
A software error occurred. Retry the emboldening function.
Error occurred when filtering this character.
A software error occurred.
Retry the filter
operation.
Error occurred when halftoning this character.
A software error occurred. Retry the halftone
operation.
Error occurred when mirroring this character.
A software error occurred. Retry the mirroring
operation.
Error occurred when outlining this character.
A software error occurred. Retry the outlining
operation.
Error occurred when saving .HDR or .GLH file.
ElixirFont cannot save the .HDR or .GLH components of the font file. Retry the operation.
Error occurred when setting character headers.
A software error occurred. Specify the character
headers again.
Error occurred when setting the font header.
A software error occurred. Redo the font header
operation.
Error occurred when shifting this character.
A software error occurred.
Retry the shift
operation.
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Error occurred when slanting this character.
A software error occurred. Retry the slanting
operation.
First select a character or a group of characters.
You attempted to select a tool without first selecting one or more characters.
Font changed from Fixed Pitch to Proportional.
This message informs you that the width of all
character cells may be different after character
transformations.
Font not loaded yet, press <F8> to load.
You attempted to perform a Save operation without first loading a font. Load a font by pressing
<F8> and selecting a font from the displayed list.
Key code is out of range. Acceptable range is 0 255.
When sampling an AFP character set, ElixirFont
searches the .KMP file for the GCID for the current key. Normally, there are always 256 GCIDs
in a .KMP file, and each code is between 0 and
255. This error message displays if the key is
greater than 255.
Loading Font file..
This message momentarily displays when ElixirFont is loading a font.
Loading/saving files.
This message momentarily displays when ElixirFont is loading or saving a file.
Load target font first.
This message displays if loading a target font for
merging is unsuccessful. Exit any loaded fonts
and retry the merge operation from the start.
Long fonts loading in XEROX toolsets
This message is applicable only if both AFP and
Xerox versions of the Font Editor are loaded on
your PC. The message displays when loading a
Xerox toolset.
Maximum number of characters reached (1024).
The number of characters in the font exceeds
1024.
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Merge mode
You selected merge mode.
Negative value is not allowed.
You attempted to enter a negative value in a numeric display box. Enter a positive number.
New font creating
This message displays when creating a new font.
Operation interrupted. Would you like to continue?
You either clicked on the [Stop] button in the
Toolbox, or pressed a key during font transformation.
Pick characters in the source Font.
This message displays when attempting to merge
characters from a source font to a target font
without first selecting one or more characters in
the source font.
Sample mode
You selected the sampling pad.
Sampling Pad does not contain any characters.
You attempted to print the sampling pad and the
pad does not contain any text.
Saving Font <name>
ElixirFont is saving the font with the specified
name.
Screen font name not found.
The .FNT or .WDT components of the SYSL and
SYSH fonts (used to display screen messages in low
resolution and high resolution modes) are missing
from drive:\ELIXIR\DESKTOP. Check for sufficient
disk space and reinstall ElixirFont.
Second character is outside the Edit Bitmap area.
When blending characters in Edit Bitmap mode,
the second character is beyond the cell frame.
Reposition the character.
Select a character or a group of characters.
You selected the Copy or Swap tools and did not
first select any characters.
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Select character for blending
You selected the Blend tool in Edit Bitmap mode.
The attached ElixiKey is not valid for running the
Font Editor.
The ElixiKey connected to the LPT1 parallel port
is incorrect. Connect the correct ElixiKey and try
loading ElixirFont.
The character cannot extend beyond the left of the
cell.
To effectively extend a character beyond the left
edge of a cell, resize the cell.
The character is already blank.
You attempted to create a blank (NULL or SPACING) character from another blank character.
The distance above, below, or leading has
changed. Do you want the line spacing adjusted?
You changed the [Distance Above], [Below], or
[Leading] fields in the Font Properties dialog box,
which affects their sum, the line spacing. The
message requests confirmation for adjusting the
line spacing value.
There is nothing to Undo.
You clicked the Undo button before performing an
operation.
There are no characters after this one.
In Edit Bitmap mode, you attempted to display the
next character while the last character of the font
displays.
There are no characters before this one.
In Edit Bitmap mode, you attempted to display the
previous character while the first character of the
font displays.
There are no more characters.
In Sampling mode, you pressed the backspace
key, but you already deleted all characters on the
pad.
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This character cannot be enlarged again.
ElixirFont does not allow you to resize a character
repeatedly (because resizing errors compound).
To resize again, exit Character Resizing mode
and retry the operation.
This character could not be merged.
An error occurred during the transfer of the character bitmap or record. Retry the operation.
Too many characters in source font - will not fit in
target font.
The number of characters in the source group,
selected for copying or merging, results in a target font that has too many characters (over 256).
Too many decimal places.
You entered a number with too many decimal
places. Retry the operation with fewer decimal
places.
Transformation failed.
A software error occurred when performing the
transformation. Retry the operation.
Unsuccessful undo.
The Undo operation failed. Retry the operation.
Use mouse or keyboard to move selected area.
This message displays when you select an area
in Edit Bitmap mode.
Warning: cannot post this character.
This message displays when the character bitmap or record was corrupted by transforming or
editing and cannot be posted.
Retry the
operation.
Warning: Character was clipped.
This message displays when
Warning: Grayscale images unsupported in Elixir
environment.
This message displays when converting IOCA
format (AFP pseg) to Elixir format. The image
grayscale converts to halftone (either black or
white) automatically.
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TROUBLESHOOTING

You must enter a name for this font.
You did not specify an External Font name for the
New Font dialog box [Properties].
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Glossary

This glossary contains a list of the basic terminology
this manual uses.
application
Any program you run on your PC. Elixir applications
are represented by icons on the Elixir Desktop. If an
Elixir application is not installed on your PC, its icon
does not display.
arrow
The screen pointer used for selecting objects.
button
An area on the screen that responds when you click
on it. For example, each dialog box has an [OK] button that accepts your entries when you click on it.
Character Set
In AFP fonts, the file that contains the font bitmap
information.
click, on an item
To momentarily press and release the left mouse button with the screen pointer on an item.
close
To exit from a window, dialog box, or the Desktop.
close box
A small white box at the left of a window header and
at the left of the menu bar. Clicking a close box on a
window header closes the window. Clicking a close
box on the menu bar exits the Desktop.
Coded Font
In AFP fonts, a file that is a table of correspondence
between character set names and code page names.
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Code Page
In AFP fonts, the file that maps keyboard entries
(code points) to graphic character IDs (GCIDs) in a
character set.
command button
A button in a dialog box that confirms or cancels an
action when you click on it. The [Cancel] button cancels the command. The [OK] button confirms and
executes the command and saves the information you
specified in a dialog box.
Converter icon
The icon that converts font, form, image, and document files.
cursor
An I-shaped screen pointer used when entering text in
a dialog box.
Desktop
The Elixir Desktop working environment, consisting of
the menu bar, the screen area, and the icons on the
screen.
dialog box
A rectangular box that displays and requests information. You enter information in fields in the dialog box,
and normally confirm your entries by clicking on an
[OK] button or by pressing <Enter>.
dimmed options
Dimmed options are menu options you cannot choose
because they do not apply to your current selection.
Also called grayed options.
directory
A list of hard disk or diskette contents. Desktop directories are represented by folder icons. Folder contents can be viewed pictorially, alphabetically, by icon,
by size, or by date.
Dispatcher icon: The icon that stores and invokes a
number of DOS commands.
DOS
Disk Operating System, the collection of programs
that gives control of a PC's resources to the user.
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double-click
To press the left mouse button twice in rapid
succession.
drag
To click on an item and move the item with the mouse
while holding down the left mouse button.
drag and drop
Used to copy an object as follows: click on an item on
the screen, hold down the left mouse button, move the
mouse to move the screen pointer to an icon, and release the mouse button.
drop
To release the mouse button after dragging an item to
an icon.
Elixir folders
The folders represented by the four top left icons on
the Desktop: the Forms, Fonts, Images, and Documents folders. Each of these folders contains an
Elixir, Input, and Output folder. See the “Folders and
directories” chapter for information about DOS subdirectories that correspond to the above folders.
extension
The three characters following the period after a file
name. In the Desktop, an extension identifies the type
of information in a file. For example, .ELX indicates
an Elixir format form file.
fast keys
See the "Keyboard shortcuts" appendix.
file name
The name of a file. The Elixir Desktop uses DOS file
naming conventions. DOS file names consist of a
base (stem) name containing up to eight characters
and an extension of up to three characters. Standard
IBM file extensions are used for AFP files.
folder icon
The Desktop icon representing a DOS directory. Folders allow you to quickly organize information on the
Desktop.
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format
To prepare or initialize a diskette so it can hold information. Formatting a diskette erases the information
on the diskette.
generic Elixir format
The DOS file format an Elixir application uses (such
as ElixirFont, ElixirImage, and ElixirForm).
GCID
Graphic Character ID, an identifier associated with
each character in an AFP font.
highlighted
A highlighted icon indicates that the icon is selected.
icon
A small symbol on the Desktop that represents an application, a file, a folder, or a peripheral device.
importing files
The process of copying non-Elixir format files from different storage media (such as the hard disk, or a diskette) to the appropriate Desktop input folder.
invoke
To start an application. Also referred to as run.
Keyboard Mapping File
When creating "pruned" Elixir versions of AFP fonts,
this ASCII .KMP file maps the GCID for each AFP font
character to the corresponding ASCII keyboard
position.
keyboard shortcut
Also called a Fast Key. A one- or two-key combination that allows you to execute an option without using
the mouse. Keyboard shortcuts are shown on each
menu beside the name of the option and are listed in
the “Keyboard shortcuts” appendix.
menu
A list of options from which you make a selection to
perform an action. A menu displays when you select
a menu title from the menu bar or from a window
header.
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menu bar
The horizontal bar displayed at the top of the Desktop
from which you access pull-down menus.
menu titles
Text that identifies a menu, displayed in a window
header or on the menu bar.
message area
A bar just below the menu bar that displays error messages or information about the activity you are
performing.
mouse button
A button on top of the mouse. The Elixir Desktop supports most actions using the left mouse button. The
right button is used for displaying icon properties for
displaying Help.
multi-select
Selecting more than one file or icon by shift-clicking
on them.
open a folder, Elixir file, application, or peripheral
device:
1.) Opening a folder icon displays a window showing
the contents of the folder. 2.) Opening an Elixir file
icon starts the application that created the file and
loads the file . 3.) Opening an application icon starts
the application. 4.) Opening a peripheral device displays a properties dialog box allowing you to set the
device parameters.
option
A word or phrase in a menu that you can select.
peripheral (device)
A printer, scanner, or diskette drive connected to your
PC.
point
To move the mouse so the screen pointer (in most
cases an arrow) rests on the desired item.
Printers icon
An icon representing a proof-printer connected to your
PC.
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pull-down menu
See menu.
raster graphics
Pictures composed of bit maps, where each element
of the picture is a dot defined as black or white.
run
To execute or start an application. Also referred to as
invoke.
Scanners icon
The icon representing a scanner connected to your
PC.
screen pointer
A pointer shaped like an arrow that displays on the
screen, and which you can move by rolling the mouse
on a flat surface.
scroll
To move a directory list in a window so you can view
different parts of the list.
scroll bar
A bar displayed on the right side of some windows
used for scrolling. The scroll bar contains a scroll arrow, + and - buttons, and a slider bar that moves
within the scroll box.
select
To click on an object or menu option. A selected item
displays as highlighted.
shift-click
To click on an object while holding down the <Shift>
key. Usually used to select multiple items.
slider bar
A bar in the scroll box at the side of some windows
that scrolls items in the window when you drag it up
and down.
Trashbin icon
The Trashbin icon is in the lower right corner of the
Desktop and represents a receptacle for items you
want to delete. You delete a file by dragging it to the
Trashbin icon.
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unselect/deselect
To cause one or more selected (highlighted) icons to
not be selected any more. The quickest way to do this
is to click on another area of the Desktop.
User Files icon
The icon that links applications to files.
User Tools icon
The icon that allows you to create and define icons for
DOS applications and batch files.
utilities
Special-purpose applications with which you can perform functions from the DOS prompt. For example,
the MEMRES utility allows you to display current
memory usage.
wildcard character
A character in a file name, usually an asterisk (*), that
specifies a matching set. For example, *.FNT represents all files that end with the .FNT extension.
window
A rectangular area on your screen in which you view
information, such as the contents of a folder. All windows contain a window header. Some windows have
scroll bars along the right side.
window header
The top of a window that displays the DOS directory
corresponding to the window contents. Some window
headers also show a close box and a number of menu
titles with pull-down menus.
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A
Acrobat Reader, documentation, 1-10
application icons, 3-5

B
Bubble Help, 1-9

C
clipboard, 3-4
code page
default, 2-2, 2-4
loading, 5-9
window, 5-5
Context sensitive Help,
1-9
conventions, 1-5
display, 1-6
mouse, 1-7
typographical, 1-6
Converter icon, 3-7
converting files, 3-15
Country Keyboard Map,
2-2
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fonts, 5-17
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creating a form, 4-6
customer support, 1-2
customer training, 1-4

D
default installation
first time, 2-12
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Dialog box Help, 1-9
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Dispatcher icon, 3-7
documentation
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Acrobat Reader,
1-10
directory, 1-10
navigating, 1-11
printing, 1-13
scrolling, 1-12
using, 1-10
word find, 1-12
zoom in/out, 1-13
Documents folder, 3-4
DOS, accessing, 3-8
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E
edit window, 5-13
editing
fonts, 5-11
ElixiDoc, 3-5, 3-6
ElixiForm
grid, 4-7
rulers, 4-7
Elixir applications
cautions, 1-2
conventions, 1-5
exiting, 1-17
forms creation advantages, 1-18
Help, 1-8
starting, 1-15
system requirements, 1-4
Elixir Web site support,
1-3
ElixirFont, 3-5, 5-1
basics, 5-1
layout, 5-2
loading a code
page, 5-9
menu bar, 5-3
using, 5-5
window, 5-3
Elixirfont
creating fonts, 5-17
editing fonts, 5-11
editing tools, 5-11,
5-14
loading fonts, 5-6
Message area, 5-5
modifying fonts,
5-17
saving, 5-18
Toolbar, 5-13
Toolbox, 5-4
Transform tool, 5-15
ElixirForm, 3-5, 4-1
adding images, 4-10
adding text, 4-9
basics, 4-1
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4-13
creating a form, 4-6
deleting elements,
4-14
drawing boxes, 4-8,
4-9
editing elements,
4-12, 4-14
layout, 4-2
loading a form, 4-17
Message area, 4-5
modifying forms,
4-12
moving elements,
4-13
overview, 4-1
proof-printing, 4-17
saving, 4-15
selecting elements,
4-12
Toolbar, 4-5
Toolbox, 4-4
using, 4-5
window, 4-3
ElixirImage, 6-1
basics, 6-1
creating an image,
6-9
editing, 6-6
editing tools, 6-6
layout, 6-1
loading a file, 6-5
menu bar, 6-2
Message area, 6-4
overview, 6-1
proof-printing, 6-11
resetting an image,
6-10
saving, 6-10
Toolbar, 6-4
Toolbox, 6-3
Transform tool, 6-7
using, 6-4
ElixirImage icon, 3-5
ELXWDATA.BAT, A-2
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3-17
deleting, 3-11
duplicating, 3-13
ELXWDATA.BAT,
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management, 3-8
moving, 3-10
overwriting, 3-14
renaming, 3-12
selecting, 3-9
folder directories, 3-4
folder structure, 3-15
font
AFP, 2-2
PC mapped, 2-2
fonts
basics, 5-2
creating, 5-17
editing, 5-11
GCID, 2-2
non-AFP components, 5-5
saving, 5-18
Fonts folder, 3-4
Forms folder, 3-4

hardware requirements,
1-4
Help, on-line, 1-8
Help hypergraphics,
1-10
Help menu, 1-9
Help pop-ups and
jumps, 1-9

G
graphics
creating, 6-9
editing, 6-6
loading, 6-5
proof-printing, 6-11
saving, 6-10
guide, organization of,
1-14
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Images folder, 3-4
installation
before installation,
2-1
custom, 2-13
default, 2-12, 2-13
first time installation,
2-11
font considerations,
2-2

J
Jobs folder, 3-4

K
KMP file, 2-3

L
licensing software, 2-5
Load Code Page dialog,
5-10
loading
fonts, 5-6
graphics, 6-5
new forms, 4-7
loading an existing form,
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M
Message area, 5-5, 6-4
message area, 4-5
modifying
fonts, 5-17
graphics, 6-6
modifying forms, 4-12
mouse, 1-7
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on-line documentation
accessing, 1-10
Acrobat Reader,
1-10
directory, 1-10
navigating, 1-11
printing, 1-13
scrolling, 1-12
using, 1-10
zoom in/out, 1-13
Organization of this
guide, 1-14
overview
Desktop, 3-1
ElixirFont, 5-1
ElixirForm, 4-1
ElixirImage, 6-1

P
Printers icon, 3-6
printing
documentation, 1-13
proof-printing
graphics, 6-11
proof-printing a form,
4-17

S
saving
fonts, 5-18
graphics, 6-10
saving a form, 4-15
Scanners icon, 3-6
software registration, 2-5
software requirements,
1-5
sub-windows, 1-16
support, customer, 1-2
Support, Web site, 1-3
system requirements,
1-4

T
Toolbar
Elixirfont, 5-13
Elixirimage, 6-4
Toolbar, ElixirForm, 4-5
Toolbox
Elixirfont, 5-4
Elixirimage, 6-3
Toolbox, ElixirForm, 4-4
training classes, 1-4
Transform tool, 6-7
Transformer icon, 3-7
Trashbin icon, 3-7
troubleshooting, A-1

Q

U

Quick Help, 1-9

undo/redo, 4-12
User Files icon, 3-5
User Tools icon, 3-6
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Release notes, 1-2
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software, 1-5
system, 1-4
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W
word find, 1-12

X
XWIN.log
installation, 2-11

Z
zoom in/out, 1-13
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